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Copyright 

This document is copyrighted by Osprey Technologies, Inc., a wholly-owned 
subsidiary of ViewCast Corporation. No part of this specification may be reproduced, 
transcribed, transmitted or stored in a retrieval system in any part or by any means 
without the express written consent of Osprey Technologies, Inc. 

Disclaimer 

Osprey Technologies, Inc. reserves the right to change any products herein at any 
time and without notice. ViewCast Corporation and Osprey Technologies, Inc. make 
no representations or warranties regarding the content of this document, and 
assume no responsibility for any errors contained herein. 

Trademark Acknowledgment 

Osprey-500, Osprey-540, and SimulStream are trademarks of Osprey Technologies, 
Inc. Microsoft, Windows XP, Windows 2000, Windows NT, NetMeeting, NetShow, and 
Video for Windows are trademarks or registered trademarks of Microsoft Corporation. 
Any other product names, trademarks, trade names, service marks, or service 
names owned or registered by any other company and mentioned herein are the 
property of their respective companies. 

FCC Notice 

This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation.  

If this device does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures: 

♦ Reorient or relocate the receiving antenna. 

♦ Increase the separation between the computer and the receiver. 

♦ Connect the computer into an outlet on a circuit different from that to which 
the receiver is connected. 

♦ Consult the dealer or an experienced radio/TV technician for help. 



  

Shielded Cables 

Connections between this device and peripherals must be made using shielded 
cables in order to maintain compliance with FCC radio emission limits. 

Modifications 

Modifications to this device not approved by Osprey Technologies, Inc. could void the 
authority granted to the user by the FCC to operate the device.  
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Chapter 1 - Getting to Know the Osprey-
540 Capture Card 

The Osprey-540 Capture Driver User’s Guide provides practical information for 
installing and configuring the hardware and software for Osprey-540 device. This 
guide has been designed with the needs of the end user in mind, particularly first-
timers and those working with existing applications. 

Symbols 

Introduction 

Features 

Software Included 

Compatible Third-Party Applications 

Getting Help 

Symbols 

 
This symbol denotes an important note or warning. 

 

This shortcut icon points more experienced users to sections or chapters 
that summarize step-by-step instructions. 

 
This symbol denotes additional information. 

Introduction 

The Osprey-540 is a single-slot PCI card that delivers uncompressed digital video 
and audio in real time to media applications. The variety of video and audio inputs 
supported by the Osprey-540 allows it to meet quality demands across a wide 
spectrum of professional and prosumer users. 

The Osprey-540 builds on many of the award winning Osprey-500 features and 
benefits bringing you a capture device designed for the media professional.  Going 
beyond the Osprey-500 series, the Osprey-540 offers several unique features 
catered to the professional media content creator including the addition of embedded 
SDI audio support and analog audio clocks locked to any of the video sources.  
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Features 

The Osprey-540 can provide to host applications audio and video from any of the 
following sources: 

♦ Decompressed DV video and audio from IEEE-1394 DV devices 

♦ Digital Video and Audio from SDI (SMPTE-295M) sources 

♦ Video from S-video/Composite sources 

♦ Digital AES/EBU Audio from digital audio sources  

♦ Audio from Balanced or Unbalanced analog sources 

The Osprey-540 also offers the following features: 

♦ Video Cropping 

♦ Video Scaling 

♦ Video Color Conversion or Reformatting 

♦ Video Software De-interlacing 

♦ Video Logo/Bitmap Overlay 

♦ Closed Captioning for Analog and SDI sources 

♦ Hardware Audio Gain/Attenuation for Analog inputs 

♦ Analog audio locked to selected video source 

♦ Analog audio/video monitoring of selected video input source 

♦ SimulStream Capable 

The Osprey-540 enables real-time streaming from a digital video (DV) source.  The 
Osprey-540 actually decodes DV video on the card, optionally scales and color 
converts the resultant digital video, and transfers the digital video directly to the 
host. The host CPU can then be used to encode the data for streaming. This is far 
superior to most IEEE-1394 DV solutions that capture DV data to the host. In these 
systems, the host CPU must first decode, scale, possibly color convert, and reformat 
the data before it can encode it for streaming. Decoding on the Osprey card leaves 
the bulk of your CPU power for creating higher-quality video streams.  

The Osprey-540 also captures digital video and audio in the formats produced by 
professional-level camera and production equipment, including SDI video with 
embedded audio, and professional digital audio (AES/EBU). Like analog and DV video 
sources, the Osprey-540 can further scale, crop, etc the SDI video being captured in 
order to provide the video in the most optimal format for further host based 
processing.  

Bitmap overlays make it easy for users to superimpose images such as company 
logos over the video stream while video is being captured. MMX accelerated de-
interlacing removes interlacing artifacts in interlaced video making the video easier 
and more efficient to encode and thus produces higher quality streaming video.  

Line-21 closed caption support is now provided for both analog and SDI inputs. 
Closed caption data can be overlaid onto the video being captured as well as 
provided as a separate stream. As a separate but synchronized text stream, closed 
caption data streams can be streamed along with audio and video.  
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With the addition of locking the analog audio clocks to any of the video sources the 
Osprey-540 provides new levels of synchronized/locked audio and video capture. 
Mixing digital video and analog audio sources produces no drift between the time 
bases of the sources.  

The selected audio and video input for capture is also redirected to the analog 
outputs on the Osprey-540. These outputs include unbalanced audio and svideo and 
composite video.  

Digital SimulStream is an added-cost software product available for the Osprey-540. 
With SimulStream any number of applications can access data being captured by a 
single board. A single board can feed multiple encoding applications even if each 
requires a different audio or video profile. Please see the SimulStreaming User’s 
Guide which is installed in the Osprey-540 Program group for details about this 
feature. 

Audio/Video Specifications 

Video Frame Rates and Performance 

Audio/Video Specifications  

Video Input 

Audio Input 

Video/Audio Output 

Audio Processing 

Hardware Video Processing 

Computing Platforms 

Hardware System 

Video Input 

♦ NTSC/PAL 

♦ Composite (RCA-style) 

♦ S-Video (Mini-DIN style) 

♦ DV (via 4pin IEEE-1394 connector) 

♦ SDI (SMPTE-259M) (BNC style) 
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Audio Input 

♦ Unbalanced stereo (RCA connectors) 

♦ Balanced stereo (XLR connectors) 

♦ SDI (SMPTE-259M) 

♦ Professional digital audio AES/EBU (XLR connector) 

♦ DV Audio (via same IEEE-1394 connector as DV Video) 

Video/Audio Output 

The video and audio inputs can be monitored via the connectors on the output 
breakout cable. The cable includes connectors for: 

Video Outputs 

♦ Composite (BNC) 

♦ S-Video (mini-DIN) 

Audio Outputs 

♦ Unbalanced audio (two RCA connectors). 

Audio Processing 

♦ Auto sample rate selection for analog inputs (32 kHz/44.1 kHz/48 kHz) 

♦ Audio sample rate down conversion based on application requirements 

♦ Audio sample rate up conversion based on application requirements 

♦ Gain and Attenuation can be controlled in hardware for analog inputs. For 
digital inputs a software gain or attenuation can be applied. 

Hardware Video Processing 

♦ DV decoding in hardware produces a decompressed video and 
uncompressed audio stream that can be captured. 

♦ Scaling can be applied in hardware to any video source before capture. 

♦ Color space conversion can be applied in hardware before video is captured 
to the host.  Supported color formats are: 

♦ RGB (32/24/16/15) 

♦ YUV (4:2:2 packed or planar YVU9/YUV12) 

♦ Grayscale (Y) 

♦ Cropping can be applied in hardware to any video source before capture. 
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♦ Brightness/Contrast/Saturation/Hue adjustments can be applied to the 
analog inputs prior to capture (hue not applicable to PAL signals). For digital 
inputs, only the first three can be adjusted.  Bypass color correction is 
available for digital inputs that allows for the digital inputs to not have any 
correction applied. This is the recommended mode for digital inputs.  

Computing Platforms 

♦ Windows 2000 Professional 

♦ Windows XP 

♦ Windows NT 4.0 

Hardware System 

♦ 32-bit/5-volt PCI card 

♦ Full PCI Rev. 2.2 compliance 

♦ Multi-board support 

Video Frame Rates and Performance 

The Osprey-540 can deliver to the host 30 frames per second (fps) full resolution 
NTSC (720x480) as well as 25 fps full resolution PAL (720x576). The Osprey-540 
uses Direct Memory Access (DMA) to efficiently perform this delivery of both video 
and audio data to the host. Once the data is in host memory, performance is directly 
affected by how the data is processed. The Osprey-540 also supports DirectDraw for 
displaying video with minimal load on the system processor. 

 

It should be noted that uncompressed video bandwidth is very large. 
Video at 640x480 with a 16bit color format at 30fps results in more than 
18Mbytes/sec of data transfer across the PCI bus. Thus PCI bandwidth 
issues, which may result due to other high bandwidth demanding devices 
on the PCI bus, can limit performance.  

For example, having PCI based SCSI controllers may consume large 
amounts of PCI bandwidth if lots of SCSI disk activity is occurring. 
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Software Included 

The products for Windows XP, Windows 2000, and Windows NT 4.0 include: 

♦ A Video for Windows compatible video capture driver capable of being 
upgraded to SimulStream 

♦ An audio Mixer and an audio Wave driver  

♦ VidCap32 - a simple video capture application allowing for capturing and 
viewing the various video features of the device 

♦ A variety of other software applications (Windows Media encoder, Windows 
Media Player, RealProducer, RealPlayer, etc.). Note that these are only 
available on the CD-ROM and not on the web-based software release.  

Compatible Third-Party Applications 

Any VFW or DShow based audio/video application should be compatible with the 
Osprey-540. If you find an application that does not appear to be compatible see the 
getting help section before contacting our support group.  

Getting Help 

Before contacting support, please do the following: 

♦ Work through the section of Chapter 3 entitled Testing the Installation for 
Windows 2000, Chapter 4 entitled Testing the Installation for Windows 
XP, or Chapter 5 entitled Testing the Installation for Windows NT. 

♦ Read through Chapter 9 - Troubleshooting. 

♦ Visit our web site at http://www.viewcast.com/ and read the Osprey-540 
FAQs by selecting Support > Osprey Product Line > FAQs. 

If you have done that and you’re still having problems, contact the Osprey Support 
Group at: 

Voice, toll free (888) 684-6622 

Voice (919) 319-9200 

Fax (919) 319-9814 

E-mail mailto:support@ospreyvideo.com 

http://www.viewcast.com/
mailto:support@ospreyvideo.com
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When you contact support, especially if it is by email, please include the following 
information: 

♦ Which operating system you are using. Certain minor aspects of the Osprey-
540 drivers are different between Windows XP, Windows 2000, and Windows 
NT 4. 

♦ Which version of the Osprey-540 driver you are using. The version 
information is on the title bar of the driver’s Control Dialog, as well as in the 
first message of the installation program. 

♦ The type of audio and video source being used (for example: PAL SDI video 
and AES/EBU audio) and the type of equipment being used as the source (for 
example: a Sony A500 Digital Betacam Deck). 

♦ Any additional details about your system configuration would be helpful – for 
example, the system speed, processor type, motherboard chipset, whether 
you have a SCSI or IDE hard drive, whether you have a network adapter 
card, and the type of display adapter card. 

♦ A detailed description of the problem.  
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Chapter 2 - Osprey-540 Hardware 

The Osprey-540 Capture Cards are 32-bit, 5-Volt  cards. They are compliant with 
version 2.2 of the PCI hardware specification. The DV option of the Osprey-540 is a 
daughter card.  Thus the Osprey-540 is actually composed of 2 cards. Below is a 
picture of the Osprey-540 (actual hardware may differ in minor ways): 

 

System Requirements 

Configuring the Video Capture Driver 

Installing the Card 

Connecting Cables 

System Requirements 

For x86 PCs, the minimum system requirements are as follows: 

♦ 90 MHz Pentium processor or higher for the hardware. Microsoft currently 
recommends a Pentium PIII 700 Xeon or better with 128Mb RAM running 
Windows 2000 or Windows XP for running the Windows Media Encoder 7. 

♦ One available PCI slot 

♦ Windows NT 4.0, Windows 2000, or Windows XP 

♦ Approximately 7.5 megabyte of storage for system files 

For optimum performance, we recommend at least the following additional features. 

Video display adapter with: 

♦ 2MBytes memory minimum (4 Mbytes or more recommended) 

♦ Direct Draw capability 

♦ An up-to-date display device driver with Direct Draw capability 
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With the Osprey-540 you can use on-board audio capture capability to 
capture sound and multiple cards to capture multiple audio streams. 
However, you still need a sound card to play back audio since the Osprey-
540 is only a capture device and not an audio playback device.  The 
Osprey-540 will only provide audio-out useful for monitoring the audio 
input, not for playback purposes. 

Configuring the Video Capture Driver 

Use the video capture application VidCap32 to access the Osprey driver Control 
Dialog described in Chapter 6 - Osprey-540 Video Control Dialog. 

VidCap32 is included with the Osprey package. It is useful for testing the installation 
and for general purpose viewing of video. Refer to Chapter 8 - VidCap32 for 
instructions on using this applet.  

Installing the Card  

 

All computer cards are sensitive to electrostatic discharge. Slight 
discharges from clothing or even from the normal work environment can 
adversely affect these cards. By following these simple guidelines, 
however, you can minimize the chance of damaging your Osprey card. 

To be used only with UL Listed computers that include instructions 
for user installed accessories. 

♦ Handle cards only by the non-conducting edges. 

♦ Do not touch the card components or any other metal parts. 

♦ Wear a grounding strap while handling the cards (especially when 
located in a high static area). 

♦ Provide a continuous ground path by leaving the power cord 
plugged into a grounded power outlet. 

Ensure that the workstation is powered OFF before installing any 
components. 

 

If you are not familiar with how to install a PCI bus card, refer to your 
system’s documentation for more complete, step-by-step instructions. 

You should install the Osprey card before installing the software driver. However, 
with Windows 2000 or Windows XP you also have the option to pre-install the 
software before installing the hardware. 
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Use the following steps to install the Osprey card:  

1. Power down the computer. Make sure that the computer’s power switch is 
turned OFF. Read caution note above for grounding precautions. 

2. Remove the computer’s cover. 

3. Locate an empty PCI slot. 

4. Remove the slot-cover screw from the empty PCI slot’s cover, set the screw 
aside, and remove the slot cover. 

5. Remove the card from its anti-static bag. 

6. Install the Osprey card into the empty slot and make sure that it is seated 
evenly in the slot. 

7. Secure the backpanel of the card with the slot’s cover screw. 

8. Replace the computer cover. 

9. Connect video and audio cables to the Osprey card. Refer to Connecting 
Cables for details of the card’s backpanel connector. 

10. Turn the computer on.  

Connecting Cables 

Connecting a Composite Source 

Connecting an S-Video Source 

Connecting an SDI Source for the Osprey-540  

Connecting an IEEE-1394 Source for the Osprey-540  

Connecting Audio Source with the Osprey-540 



Chapter 2 - Osprey-540 Hardware 

22  Osprey-540 User's Guide – Version 2.1.5 

The Osprey-540 board has four connectors on the back plate for audio and video: 

 

Osprey-540 Input Breakout Cable 

 S-Video 
Unbalanced Audio 
Left (RCA style) 

Unbalanced Audio 
Right (RCA style)

Composite Video 
(RCA style) 

Balanced Audio 
Left (XLR style) 

Balanced Audio 
Right (XLR style) 

Digital AES/EBU Audio

S-Video 

RCA style

XLR style 

Connector Styles 

 

The breakout connector has inputs for composite video, S-Video, balanced and 
unbalanced audio, and professional digital audio. The breakout cable has a set (L/R) 
of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR) audio 
connectors. Additionally, the right XLR balanced input also is used as the professional 
digital audio input. 

 
The input breakout cable is ViewCast Part Number 34-05009-01. 
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Osprey-540 Output Breakout Cable 

S-Video 
Unbalanced Audio 
Left (RCA style) 

Unbalanced Audio 
Right (RCA style) 

Composite Video 
(BNC style)  

The output breakout cable has a set (L/R) of unbalanced RCA style audio connectors, 
a S-video connector, and a BNC style video connector. 

 
The output breakout cable is ViewCast Part Number 34-05008-01. 

Rack-mount Panel 

 

A rack mount version of the breakout input cable is also available. The 1 unit high 
rack mount input panel has the same inputs as the cable but includes two sets of 
inputs. However, the composite video connection on the rack mount panel is a BNC 
style connector.  Thus a single rack mount input unit provides for two Osprey-540 
cards. The rack mount unit is pictured above. 

 
The rack-mount breakout box is ViewCast Part Number 95-00151-02. 

 
Exact connector layouts are subject to change. 
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Connecting a Composite Source 

If your video source provides only composite video, connect the source’s output 
cable to the Composite Video In connector. This is a RCA-style connector on the 
breakout cable. On the rack-mount panel, the composite video connection is a BNC 
connector. 

A BNC to RCA adapter is provided if you don’t have a BNC composite cable.  

Connecting an S-Video Source 

If your video source supports S-Video, connect the source’s output cable to the S-
Video In connector on the breakout cable. Compared to composite signals, S-Video 
provides a sharper image with better color separation. S-Video uses a four-pin mini-
DIN connector that provides separate Y (luminance) and C (chrominance) signals. 
Refer to Chapter 6 - Osprey-540 Video Control Dialog for instructions on 
configuring the driver for S-Video.  

Connecting an SDI Source for the Osprey-540  

The Osprey-540 has a BNC connector for SDI (SMPTE-259M) video. A high quality 
SDI-qualified cable should be used when utilizing this connection, especially when 
the cable length is long. SDI carries both digital video and embedded digital audio, 
and the Osprey-540 can capture both.  

Connecting an IEEE-1394 Source for the Osprey-540  

The Osprey-540 has a DV input. DV carries digital audio and video and both can be 
independently used by the Osprey-540. The DV input is a 4 pin IEEE-1394 
connection.  

Connecting Audio with the Osprey-540 

The Osprey-540 has a variety of audio inputs, both analog and digital. The typical 
consumer will probably find the unbalanced analog RCA audio inputs to be the most 
useful. Balanced audio inputs (via XLR connectors) provide cleaner audio especially if 
the cable length is very long. The prosumer may have a DV camera source and may 
choose to use the audio embedded in the IEEE-1394 DV stream.  The professional or 
broadcast user may choose to use the digital audio embedded in the SDI (SMPTE-
295m) signal. The breakout cable contains a single professional AES/EBU stereo 
digital audio input. This input is shared with the right balanced analog input to 
prevent having both balanced audio and professional digital audio connected at the 
same time. 

The selection of audio input to capture is independent of the video input selection. 
For example, even if you choose to use DV video as a source, you can still opt to use 
the analog balanced inputs instead of audio embedded in the DV stream.  
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Chapter 3 - Installing the Software - 
Windows 2000 

 

The Windows NT 4.0 Osprey drivers do not work with Windows 2000. If 
your Osprey card(s) were installed under the Windows NT 4.0 operating 
system and the PC has now been upgraded to Windows 2000, you need to 
install the Windows 2000 drivers. 

Please note: 
♦ Administrative privileges are required for installation. 
♦ Before installing software, check the ViewCast.com support 

website or the ftp site for the any driver update releases 
subsequent to the software shipped on your CD. For the 
ViewCast.com support website, go to 
http://www.ospreyvideo.com/> Downloads > Software & 
Drivers > select Win2000 and Osprey-540 from the table. To 
reach the ViewCast.com ftp site, go to 
ftp://ftp.viewcast.com/pub/OSP-540/win2000/latest. It's 
a good idea to check these sites periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what displays on your computer screen. In some cases, 
version numbers and other minor differences may display in the 
installation you are running. 

Basics: Installing From CD 

Basics: Downloading and Installing Updated Drivers 

Canceling Out of the Found New Hardware Wizard 

Two Install Scenarios 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 
not Installed 

Testing the Installation 

Uninstalling the Software 

http://www.viewcast.com/
ftp://ftp.viewcast.com/pub/OSP-500/win2000/latest
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Basics: Installing From CD  

If necessary, follow the directions in Chapter 2 - Osprey-540 Hardware to install 
the Osprey card. This software installation procedure works properly only if the card 
is already installed. 

1. Turn on the machine and start Windows 2000. 
2. Cancel out of the Found New Hardware wizard. 
3. If you are updating from a previous version of the driver, it is necessary to 

uninstall the old driver before installing the new driver. Please refer to 
Uninstalling the Software for instructions. 

4. Insert the Osprey-540 Driver CD into your CDROM drive. The installation 
instructions assume this is the (D:) drive. Substitute the proper drive as it is 
configured on your system, if necessary. 

5. Run the installation program 
a. Click the Start button 
b. Click Run 

c. Enter D:\Win2000\Setup in the dialog box 
d. Click OK 

6. The installation program steps are self-explanatory for many users. If you need 
additional information, please refer to the section entitled Option A: Run the 
Installation Program (Recommended). 

7. The driver and demo program are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest that you 
test the driver immediately. Please refer to Testing the Installation for 
Windows 2000. 

Basics: Downloading and Installing 
Updated Drivers  

1. The latest software drivers for Osprey-540 Capture Cards are available via FTP 
(file transfer protocol) at the following locations: 

ftp://ftp.viewcast.com/pub/OSP-540/win2000/latest 

There are also links to the drivers from our web site at 
http://www.ospreyvideo.com. 

2. It is necessary to uninstall your existing Osprey-540 driver before installing a 
newer version of the driver. Follow the instructions in Uninstalling the Software 
and restart your computer before beginning the new install procedure. 

ftp://ftp.viewcast.com/pub/OSP-500/win2000/latest
http://www.ospreyvideo.com/
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3. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com/- and then click on the list of directories that display 
until you reach the win2000/latest location. Refer to your browser’s help files 
for more specific and detailed assistance. 

4. Download the web package file in win2000/latest to your hard disk. 
5. The Found New Hardware wizard displays detecting each Osprey-540 card in 

the computer. Follow the directions in Canceling Out of the Found New 
Hardware Wizard at each prompt. 

6. Run the web package program: 
a. Click the Start button. 

b. Click Run. 
c. Enter <pathname> in the dialog box, where <pathname> is the location 

and name of the file that you have downloaded. 
d. Click OK. 

e. The program prompts for a temporary location for unpacking the install 
files. 

f. See Option A: Run the Installation Program (Recommended) for a full 
description of the Installation Program steps. 

 

These files are not automatically deleted after setup has run. This feature 
exists to offer the option of performing the manual Plug and Play install 
later. If you want to conserve disk space, make a note of where these 
files are being unpacked, and delete them after the install. 

Canceling Out of the Found New Hardware Wizard  

When installing an updated Osprey-540 driver, first uninstall the existing driver and 
reboot the computer. The Found New Hardware wizard runs after rebooting. To 
cancel out the Found New Hardware wizard: 

The Digital Signature Not Found window displays for the Osprey-540 video 
capture device. 

 

ftp://ftp.viewcast.com/
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1. Click No. 
The Completing Found New Hardware wizard window displays. 

 

2. Click Finish. 

The Digital Signature Not Found window displays for the Osprey-540 audio 
capture device. 
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3. Click No. 
The Completing Found New Hardware wizard window displays. 

 

4. Click Finish.  

Two Install Scenarios 

There are two installation scenarios that might apply: 

♦ Scenario 1: Osprey Card(s) not Physically Installed in the PC 
♦ Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 

not Installed 

In all cases, the most efficient and complete installation method is to run the 
setup.exe program on the product CD or in the web package that you downloaded. 
The setup program automates the Plug and Play steps required to install the drivers 
and ensures that they are performed correctly. It also installs the bundled applets 
and User's Guide. If you have multiple Osprey capture cards in the system, it 
configures all of the boards at the same time. 

 

You can skip the detailed instructions if you are upgrading from one 
Osprey driver version to another. Just run the setup.exe file to install all 
the updated components. 
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Scenario 1: Osprey Card(s) not Physically Installed in the PC  

This Pre-install Scenario is the method that we recommend if you are installing an 
Osprey card for the first time on a system and the Osprey software has not yet been 
installed. After the install is run and as soon as an Osprey card is installed in the PC, 
the card is detected and its drivers are started automatically. 

Using Windows Explorer, locate and access the CD-ROM drive containing the Osprey 
Installation CD-ROM. 

1. Navigate to the WIN2000 directory. 

2. Double-click SETUP.EXE. 
The Osprey-540 Video and Audio Capture Driver window displays. 

 

3. Click Next. 
The Information window displays. 
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4. Click Next. 
The Software License Agreement window displays. 

 

5. Click Yes to accept the End User Software License Agreement. If you do not 
wish to accept the agreement, click No to terminate the installation routine. 
The Signal Type window displays. 
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6. Click Next. 
The Choose Destination Location window displays. 

 

7. If you wish to change the destination location for the files, click Browse. Click 
Next. 
The Select Program Folder window displays. 
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8. If you wish to change the program folder, type the new name in the Program 
Folders field. Click Next. 

The Start Copying Files window displays. 

 

9. If there are any settings to be changed prior to installation, click Back to return 
to the previous windows. Click Next. 
A question dialog window displays. 

 

10. Click Yes to continue the installation process. 
The Osprey Video Division Offers Shortcuts window displays. 

 

11. Click Yes to place the shortcut on your desktop.  If you do not want the 
shortcut on your desktop, click No. 
A Question Dialog window displays. 
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12. Click Yes. 
The Setup Complete window displays. 

 

13. Click Finish to complete the installation. 

If you are not installing the Osprey card at this time, click No then Finish to 
proceed.  When you start your computer after installing the Osprey hardware, the 
Found New Hardware Wizard runs upon detecting new hardware.  The sequence 
of windows are similar to that in Appendix H - Adding/Moving Boards in 
Windows 2000. 

 

The Osprey card does not need to be installed at this time. You also do 
not need to restart the computer at this time. 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey 
Software not Installed 

In this case you have two options: 

♦ Option A: Run the Installation Program (Recommended) 
♦ Option B: Use the New Hardware Found Wizard (Not Recommended) 

Option A: Run the Installation Program (Recommended) 

When windows 2000 is started for the first time after the Osprey card is installed, 
the Found New Hardware wizard displays one or more times. After Windows 2000 
has finished starting, cancel out of the Found New Hardware Wizard. 
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To install the Osprey drivers:  

1. Using Windows Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 
3. Double-click SETUP.EXE. 

The Osprey-540 Video and Audio Capture Driver window displays. 

 

4. Click Next. 

The Information window displays. 
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5. Click Next. 
The Software License Agreement window displays. 

 

6. Click Yes to accept the End User Software License Agreement. If you do not 
wish to accept the agreement, click No to terminate the installation routine. 
The Signal Type window displays. 
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7. Click Next. 
The Choose Destination Location window displays. 

 

8. If you wish to change the destination location for the files, click Browse. Click 
Next. 
The Select Program Folder window displays. 
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9. If you wish to change the program folder, type the new name in the Program 
Folders field. Click Next. 

The Start Copying Files window displays. 

 

10. Click Next. 
The Digital Signature Not Found window displays. 

 

11. Click Yes. 

The Digital Signature Not Found window displays. 
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12. If there are any settings to be changed prior to installation, click Back to return 
to the previous windows. Click Next. 

A question dialog window displays. 

 

13. Click Yes to continue the installation process. 
A question dialog window displays. 

 

14. Click Yes to continue the installation process. 
The Osprey Video Division Offers Shortcuts window displays. 

 

15. Click Yes to place the shortcut on your desktop.  If you do not want the 
shortcut on your desktop, click No. 
The Setup Complete window displays. 
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16. Click Finish to complete the installation and restart your computer. You must 
restart your computer before you can use the Osprey-540 card. 

Option B: Use the Found New Hardware Wizard (Not 
Recommended)  

This method is more complicated than Option A. It is particularly inconvenient if you 
are installing multiple cards at once, since each card has to be set up separately. 
This process installs only the driver and is useful only for updating the driver 
component. Furthermore, to get the sample applications and other required items, 
you must still run the setup.exe program detailed in Scenario 2, Option A. 

 

The following windows and instructions assume that you are working with 
a computer on which the Osprey-540 software has never previously been 
installed. 

When Windows 2000 starts, it detects the new card(s) and starts the Found New 
Hardware Wizard. 

 

Please carefully note the terminology in the Found New Hardware Wizard. 

For all Bt/Ct878-based Osprey cards, the Wizard detects two logical 
devices for each card - a Multimedia Video Controller device and a 
Multimedia Controller device. 

The Multimedia Video Controller corresponds to the Osprey-540 video 
device. The Multimedia Controller corresponds to the Osprey-540 audio 
device. 

The first window to display is the Found New Hardware Wizard. 
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1. Click Next. 
The Install Hardware Device Drivers window displays. 

 

2. Click the Display option and click Next to continue. 

The Hardware Type window displays. 
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3. Scroll down to Sound, video and game controllers, click to select, then click 
Next to continue. 

The Select a Device Driver window displays. 

 

4. Click Have Disk. 
The Install from Disk window displays. 
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5. The default path is usually A:\. Reset the path to the directory containing the 
Osprey-540 install files. In this example they are in E:\WINNT. Click OK once 
the path has been set. 
The Select a Device Driver window displays. 

 

6. Select the Osprey-540 Video Capture Device and click Next. 
A warning message displays. 

 

7. Click Yes. 
The Start Device Driver Installation window displays. 
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8. Click Next. 
The Digital Signature Not Found window displays. 

 

9. Click Yes. 
The Completion window displays. 

 

10. Click Finish. 

 

At this point the Osprey-540 video driver has been installed. You should 
now get another Found New Hardware popup – this time for the 
Multimedia Controller (i.e., the audio device) - and a new Digital 
Signature Message for the Osprey-540 audio driver. 
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The second Found New Hardware Wizard window displays. 

 

11. Click Next. 
The Install Hardware Device Drivers window displays. 
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12. Click to select the Display radio button and click Next. 
The second Digital Signature Not Found window displays. 

 

13. Click Have Disk. 

The Install from Disk window displays. 

 

14. The default path is usually A:\. Reset the path to the directory containing the 
Osprey-540 install files. In this example they are in E:\WINNT. Click OK once 
the path has been set. 
The Select a Device Driver window displays. 
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15. Click to select Osprey-540 Audio Capture Device and click Next. 
A warning message displays. 

 

16. Click Yes. 
The Start Device Driver Installation window displays. 

 

17. Click Next. 
The Digital Signature Not Found window displays. 
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18. Click Yes. 
The Completing the Found New Hardware Wizard window displays. 

 

19. Click Finish. 

 

This process installs only the driver and is useful only for updating the 
driver component. To get the sample applications and other required 
items, you must still run the setup.exe program. See Scenario 2, Option A 
for those instructions. 

Indeo 

Ligos Technology's Indeo codec is provided on the Osprey-540 CD. Double-click on 
file Indeo\Disk1\Setup.exe to install this package containing compression and 
color formats. 

Please see Ligos Technology's Indeo in Chapter 10 - VidCap32, AmCap, and 
Included Demo Programs for a description of this package. 
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Testing the Installation for Windows 2000  

1. Verify that the hardware installation is complete according to the directions in 
Chapter 2 - Osprey-540 Hardware. 

2. Connect a video signal source to one of the Osprey-540 connectors 
(Composite/S-video/SDI/DV). 

3. Open the Osprey-540 group in the Start menu. 
4. Click the VidCap32 icon. Refer to Chapter 8 - VidCap32 for more information 

on this application. 

5. If your input is composite video, the screen displays a still video frame from the 
Osprey-540 board. Click the Overlay button. The screen should display moving 
video frames. If your input choice is not composite video, select the Video 
Source option under the Options menu. This brings up the Osprey-540’s video 
capture driver configuration box where you can select your video input. 

6. If the video area does not contain video, it could be for one of the following 
reasons: 

a. The driver is looking for video on the wrong input connector. You can either 
move the video cable to another connector or reconfigure the driver using 
its Control Dialog. Refer to Chapter 6 - Osprey-540 Video Control 
Dialog. 

b. The video source is not turned on or activated. 
7. If the video area is scrambled or has bad color, the signal format of your video 

source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL equipment 
always need to change the driver’s signal format the first time they run the 
driver. Refer to Chapter 6 - Osprey-540 Video Control Dialog for more 
information.  

Uninstalling the Software  

If you need to remove the Osprey driver from your system:  

1. Open the Control Panel. 
2. Double-click Add/Remove Programs. 
3. Click to select Change or Remove Programs. 
4. Highlight the Osprey-540 Driver entry. 

5. Click Change/Remove in the Osprey entry. 
The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete. 
8. Please reboot your computer to finish removing the driver. 
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Chapter 4 – Installing the Software – 
Windows XP 

 

The Windows NT 4.0 Osprey drivers do not work with Windows XP. If your 
Osprey card(s) were installed under the Windows NT 4.0 operating 
system and the PC has now been upgraded to Windows XP, you need to 
install the Windows XP drivers. 

Please note: 
♦ Administrative privileges are required for installation. 
♦ Before installing software, check the ViewCast.com support 

website or the ftp site for the any driver update releases 
subsequent to the software shipped on your CD. For the 
ViewCast.com support website, go to 
http://www.ospreyvideo.com/> Downloads > Software & 
Drivers > select WinXP and Osprey-540 from the table. To reach 
the ViewCast.com ftp site, go to 
ftp://ftp.viewcast.com/pub/OSP-540/winXP/latest. It's a 
good idea to check these sites periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what displays on your computer screen. In some cases, 
version numbers and other minor differences may display in the 
installation you are running. 

Basics: Installing From CD 

Basics: Downloading and Installing Updated Drivers 

Canceling Out of the Found New Hardware Wizard 

Two Install Scenarios 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 
not Installed 

Testing the Installation 

Uninstalling the Software 

Basics: Installing From CD  

If necessary, follow the directions in Chapter 2 - Osprey-540 Hardware to install 
the Osprey card. This software installation procedure works properly only if the card 
is already installed. 

1. Turn on the machine and start Windows XP. 

http://www.viewcast.com/
ftp://ftp.viewcast.com/pub/OSP-500/winXP/latest
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2. Cancel out of the Found New Hardware wizard. 
3. If you are updating from a previous version of the driver, it is necessary to 

uninstall the old driver before installing the new driver. Please refer to 
Uninstalling the Software for instructions. 

4. Insert the Osprey-540 Driver CD into your CDROM drive. The installation 
instructions assume this is the (D:) drive. Substitute the proper drive as it is 
configured on your system, if necessary. 

5. Run the installation program 
a. Click the Start button 
b. Click Run 

c. Enter D:\WinXP\Setup in the dialog box 
d. Click OK 

6. The installation program steps are self-explanatory for many users. If you need 
additional information, please refer to the section entitled Option A: Run the 
Installation Program (Recommended). 

7. The driver and demo program are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest that you 
test the driver immediately. Please refer to Testing the Installation for 
Windows XP. 

Basics: Downloading and Installing 
Updated Drivers  

1. The latest software drivers for Osprey-540 Capture Cards are available via FTP 
(file transfer protocol) at the following locations: 

ftp://ftp.viewcast.com/pub/OSP-540/winXP/latest 

There are also links to the drivers from our web site at 
http://www.ospreyvideo.com. 

2. It is necessary to uninstall your existing Osprey-540 driver before installing a 
newer version of the driver. Follow the instructions in Uninstalling the Software 
and restart your computer before beginning the new install procedure. 

3. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com/- and then click on the list of directories that display 
until you reach the winXP/latest location. Refer to your browser’s help files 
for more specific and detailed assistance. 

4. Download the web package file in winXP/latest to your hard disk. 
5. The Found New Hardware wizard displays detecting each Osprey-540 card in 

the computer. Follow the directions in Canceling Out of the Found New 
Hardware Wizard at each prompt. 

ftp://ftp.viewcast.com/pub/OSP-500/winXP/latest
http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/
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6. Run the web package program: 
a. Click the Start button. 

b. Click Run. 
c. Enter <pathname> in the dialog box, where <pathname> is the location 

and name of the file that you have downloaded. 
d. Click OK. 

e. The program prompts for a temporary location for unpacking the install 
files. 

f. See Option A: Run the Installation Program (Recommended) for a full 
description of the Installation Program steps. 

 

These files are not automatically deleted after setup has run. This feature 
exists to offer the option of performing the manual Plug and Play install 
later. If you want to conserve disk space, make a note of where these 
files are being unpacked, and delete them after the install. 

Two Install Scenarios 

There are two installation scenarios that might apply: 

♦ Scenario 1: Osprey Card(s) not Physically Installed in the PC 
♦ Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 

not Installed 

In all cases, the most efficient and complete installation method is to run the 
setup.exe program on the product CD or in the web package that you downloaded. 
The setup program automates the Plug and Play steps required to install the drivers 
and ensures that they are performed correctly. It also installs the bundled applets 
and User's Guide. If you have multiple Osprey capture cards in the system, it 
configures all of the boards at the same time. 

 

You can skip the detailed instructions if you are upgrading from one 
Osprey driver version to another. Just run the setup.exe file to install all 
the updated components. 
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Scenario 1: Osprey Card(s) not Physically Installed in the PC  

This Pre-install Scenario is the method that we recommend if you are installing an 
Osprey card for the first time on a system and the Osprey software has not yet been 
installed. After the install is run and as soon as an Osprey card is installed in the PC, 
the card is detected and its drivers are started automatically. 

Using Windows Explorer, locate and access the CD-ROM drive containing the Osprey 
Installation CD-ROM. 

1. Navigate to the WINXP directory. 

2. Double-click SETUP.EXE. 
The Osprey-540 Video and Audio Capture Driver window displays. 

 

3. Click Next. 

The Information window displays. 
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4. Click Next. 
The Software License Agreement window displays. 

 

5. Click Yes to accept the End User Software License Agreement. If you do not 
wish to accept the agreement, click No to terminate the installation routine. 
The Select Components window displays. 
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6. Click Next. 
The Choose Destination Location window displays. 

 

7. Click Next. 
The Select Program Folder window displays. 
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8. Click Next. 
The Start Copying Files window displays. 

 

9. Click Next. 
A question window displays. 

 

10. Click Yes to continue the installation process. 
A question window displays. 

 

11. Click Yes. 

A question window displays. 
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12. Click Yes. 
A question window displays. 

 

13. Click Yes. 
A question window displays. 

 

14. Click Yes to place the shortcut on your desktop.  If you do not want the 
shortcut on your desktop, click No. 
The Setup Complete window displays. 

 

15. Click Finish. 
The Setup Complete window displays. 

If you are not installing the Osprey card at this time, click No then Finish to 
proceed.  When you start your computer after installing the Osprey hardware, the 
Found New Hardware Wizard runs upon detecting new hardware.  The sequence 
of windows are similar to that in Appendix H - Adding/Moving Boards in 
Windows 2000. 

 

The Osprey card does not need to be installed at this time. You also do 
not need to restart the computer at this time. 
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Scenario 2: Osprey Card(s) Physically Installed, but Osprey 
Software not Installed 

In this case you have two options: 

♦ Option A: Run the Installation Program (Recommended) 
♦ Option B: Use the New Hardware Found Wizard (Not Recommended) 

Option A: Run the Installation Program (Recommended) 

When Windows XP is started for the first time after the Osprey card is installed, the 
Found New Hardware wizard displays one or more times. After Windows XP has 
finished starting, cancel out of the Found New Hardware Wizard. 

To install the Osprey drivers:  

1. Using Windows Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WINXP directory. 
3. Double-click SETUP.EXE. 

The Osprey-540 Video and Audio Capture Driver window displays. 
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4. Click Next. 
The Information window displays. 

 

5. Click Next. 
The Software License Agreement window displays. 
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6. Click Yes to accept the End User Software License Agreement. If you do not 
wish to accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 

 

7. Click Next. 
The Choose Destination Location window displays. 
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8. Click Next. 
The Select Program Folder window displays. 

 

9. Click Next. 
The Start Copying Files window displays. 

 

10. Click Next. 
A question window displays. 

 



 Chapter 4 – Installing the Software – Windows XP 

Osprey-540 User's Guide – Version 2.1.5  63 

11. Click Yes. 
A question window displays. 

 

12. Click Yes. 
A question window displays. 

 

13. Click Yes. 

A question window displays. 

 

14. Click Yes to place the shortcut on your desktop.  If you do not want the 
shortcut on your desktop, click No. 
The Setup Complete window displays. 

 



Chapter 4 – Installing the Software – Windows XP 

64  Osprey-540 User's Guide – Version 2.1.5 

15. Click Finish to complete the installation and restart your computer. You must 
restart your computer before you can use the Osprey-540 card. 

Option B: Use the Found New Hardware Wizard (Not 
Recommended)  

This method is more complicated than Option A. It is particularly inconvenient if you 
are installing multiple cards at once, since each card has to be set up separately. 
This process installs only the driver and is useful only for updating the driver 
component. Furthermore, to get the sample applications and other required items, 
you must still run the setup.exe program detailed in Scenario 2, Option A. 

 

The following windows and instructions assume that you are working with 
a computer on which the Osprey-540 software has never previously been 
installed. 

When Windows XP starts, it detects the new card(s) and starts the Found New 
Hardware Wizard. 

 

Please carefully note the terminology in the Found New Hardware Wizard. 

For all Bt/Ct878-based Osprey cards, the Wizard detects two logical 
devices for each card - a Multimedia Video Controller device and a 
Multimedia Controller device. 

The Multimedia Video Controller corresponds to the Osprey-540 video 
device. The Multimedia Controller corresponds to the Osprey-540 audio 
device. 

The first window to display is the Found New Hardware Wizard. 
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1. Click to select Install from a list or specific location. 
2. Click Next. 

The Found New Hardware Wizard window displays. 

 

3. Click to select Search for the best driver in these locations.  If the driver is 
not on a CD-ROM, type the destination in the field. 

4. Click Next. 
The Found New Hardware Wizard window displays. 
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5. Click Continue Anyway. 
The Found New Hardware Wizard window displays. 

 

6. Click Finish. 
The Found New Hardware Wizard window displays. 
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7. Click to select Install from a list or specific location. 
8. Click Next. 

 

9. Click to select Search for the best driver in these locations.  If the driver is 
not on a CD-ROM, type the destination in the field. 

10. Click Next. 
The Found New Hardware Wizard window displays. 
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11. Click Continue Anyway. 
The Found New Hardware Wizard window displays. 

 

 

After completing the Found New Hardware Wizard, the software 
applications must also be installed.  Navigate to the WinXP directory on 
the CD-ROM and double-click SETUP.EXE.  For detailed instructions, see 
Option A. 

Indeo 

Ligos Technology's Indeo codec is provided on the Osprey-540 CD. Double-click on 
file Indeo\Disk1\Setup.exe to install this package containing compression and 
color formats. 

Please see Ligos Technology's Indeo in Chapter 10 - VidCap32, AmCap, and 
Included Demo Programs for a description of this package. 
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Testing the Installation for Windows XP  

1. Verify that the hardware installation is complete according to the directions in 
Chapter 2 - Osprey-540 Hardware. 

2. Connect a video signal source to one of the Osprey-540 connectors 
(Composite/S-video/SDI/DV). 

3. Open the Osprey-540 group in the Start menu. 
4. Click the VidCap32 icon. Refer to Chapter 8 - VidCap32 for more information 

on this application. 

5. If your input is composite video, the screen displays a still video frame from the 
Osprey-540 board. Click the Overlay button. The screen should display moving 
video frames. If your input choice is not composite video, select the Video 
Source option under the Options menu. This brings up the Osprey-540’s video 
capture driver configuration box where you can select your video input. 

6. If the video area does not contain video, it could be for one of the following 
reasons: 

a. The driver is looking for video on the wrong input connector. You can either 
move the video cable to another connector or reconfigure the driver using 
its Control Dialog. Refer to Chapter 6 - Osprey-540 Video Control 
Dialog. 

b. The video source is not turned on or activated. 
7. If the video area is scrambled or has bad color, the signal format of your video 

source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL equipment 
always need to change the driver’s signal format the first time they run the 
driver. Refer to Chapter 6 - Osprey-540 Video Control Dialog for more 
information.  

Uninstalling the Software  

If you need to remove the Osprey driver from your system:  

1. Open the Control Panel. 
2. Double-click Add/Remove Programs. 
3. Click to select Change or Remove Programs. 
4. Highlight the Osprey-540 Driver entry. 

5. Click Change/Remove in the Osprey entry. 
The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete. 
8. Please reboot your computer to finish removing the driver. 
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Chapter 5 - Installing the Software - 
Windows NT 4.0 

The Osprey Capture Card products contains a single CD for Windows 2000 and 
Windows NT 4.0. 

After you’ve installed the software, you can test the card and software by running 
the included application program VidCap32. 

 

Please note: 
♦ Administrative privileges are required for installation. 
♦ Before installing software, check the ViewCast.com support 

website or the ftp site for the any driver update releases 
subsequent to the software shipped on your CD. For the 
ViewCast.com support website, go to 
http://www.ospreyvideo.com/> Downloads > Software & 
Drivers > select WinNT and Osprey-540 from the table. To reach 
the ViewCast.com ftp site, go to 
ftp://ftp.viewcast.com/pub/OSP-540/winnt/latest. It's a 
good idea to check these sites periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what displays on your computer screen. In some cases, 
version numbers and other minor differences may display in the 
installation you are running. 

♦ If you already have the Osprey driver software installed on your 
system and are updating it, you do not have to remove the old 
version before installing the new version. The installation program 
removes or replaces any files or registry settings that are 
outdated. 

♦ If you have not installed Microsoft's DirectXMedia package, it is 
required to run Windows Media Encoder 7.  It is included on your 
Osprey-540 CD-ROM.   

The DirectXMedia package is distributed with Microsoft's DirectX 7.0a SDK 
which can be ordered on CD from: 

http://msdn.microsoft.com/directx/downloads.asp 

The DirectXMedia package has also been distributed on the Platform SDK 
CD-ROM within the MSDN subscriptions. 

Installing from CD 

Downloading and Installing Updated Drivers 

Setup Program: Details 

Testing the Installation for Windows NT 

Uninstalling the Software 

http://www.viewcast.com/
ftp://ftp.viewcast.com/pub/OSP-500/winnt/latest
http://msdn.microsoft.com/directx/downloads.asp
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Installing from CD  

If necessary, follow the directions in Chapter 2 - Osprey-540 Hardware to install 
the Osprey card. This software installation procedure works properly only if the card 
is already installed. 

1. Turn on the machine and start Windows NT. 
2. If you are updating from a previous version of the driver, it is necessary to 

uninstall the old driver before installing the new driver. Please refer to 
Uninstalling the Software for instructions. 

3. Insert the Osprey-540 Driver CD into your CDROM drive. The installation 
instructions assume this is the (D:) drive. Substitute the proper drive as it is 
configured on your system, if necessary. 

4. Run the installation program 

a. Click the Start button 
b. Click Run 
c. Enter D:\WinNT\Setup in the dialog box 

d. Click OK 
5. The installation program steps are self-explanatory for many users. If you need 

additional information, please refer to the section entitled Setup Program: 
Details. 

6. The driver and demo program are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest you test 
the driver immediately. Refer to the section entitled Testing the Installation 
for Windows NT.  

Downloading and Installing Updated 
Drivers  

1. Install the Osprey board in the PC if you have not already done so, turn on the 
machine and start Windows NT. 

2. The latest software drivers for Osprey-540 Capture Cards are available via FTP 
(file transfer protocol) at the following location: 
ftp://ftp.viewcast.com/pub/OSP-540/winnt/latest 

There are also links to the drivers from our web site at 
http://www.ospreyvideo.com/. 

3. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com - and then click on the list of directories that display 
until you have reached the winnt/latest location. Refer to your browser’s help 
files for more specific and detailed assistance. 

ftp://ftp.viewcast.com/pub/OSP-500/winnt/latest
http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/
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4. Download the web package in winnt/latest to your hard drive. 
5. It is necessary to uninstall your existing Osprey-540 driver before installing a 

newer version of the driver. Follow the instructions in Uninstalling the Software 
and restart your computer before beginning the new install procedure. 

6. Run the web package program 
a. Click the Start button 

b. Click Run 
c. Enter <pathname> in the dialog box, where <pathname> is the location 

and name of the file that you have downloaded 
d. Click OK. 

7. The program prompts you for a temporary location in which to unpack the 
installation files and starts the setup program. The setup program guides you 
through the installation steps. For many users this process is self-explanatory. 
If you need additional information, please refer to the section entitled Setup 
Program: Details. 

 

The installation files are not automatically deleted after setup has run. If 
you want to conserve disk space, make a note of the temporary location 
where these files are being unpacked and delete them after the 
installation. 

8. You must restart the computer before the driver and sample applications are 
ready for use. We recommend that you test the driver immediately after 
restarting your computer.  

Setup Program: Details  

The setup program presents a sequence of windows and dialogs to guide you 
through the setup process. In general, click the Next > button to continue to the 
next screen. At any point you can click < Back to return to a previous screen or 
Cancel to exit the installation. 

1. The installation of the Osprey-540 Driver for Windows NT begins with a 
confirmation that the setup program is beginning. 
The Welcome window displays. 

2. Click Next. 
The Information window displays. 

3. Click Next. 

The Software License Agreement window displays. 

4. Click Next. 
The Signal Type window displays. 

5. Click to select the signal format default for your Osprey-540. 

6. Click Next. 
The Choose Destination Location window displays. 

7. Click Next. 

The Select Program Folder window displays. 



Chapter 5 - Installing the Software - Windows NT 4.0 

74  Osprey-540 User's Guide – Version 2.1.5 

 

The destination location is the folder where VidCap32 (the demo applet), 
ReadMe, and other auxiliary files are located. (The core video capture 
driver files are located in Windows NT system directories regardless of the 
destination location chosen here.) The default location, in the Program 
Files folder, should be appropriate for most systems. Click the Browse 
button near the bottom of the dialog if you want to change the location. 

8. Click Next. 
The Start Copying Files window displays. 

 

The setup program suggests placing the Osprey icons in a new program 
folder entitled “Osprey 540.” You can change this name by editing the 
Program Folders field, or you can add the icons to an existing folder by 
highlighting it in the Existing Folders window. 

9. Click Yes to place the Osprey Special Offers shortcut on your desktop.  If you 
do not want the shortcut on your desktop, click No. 
If another kind of video capture driver is already installed on your system, the 
question below displays. 

 

10. Click Yes to make the Osprey driver your primary video capture driver, unless 
you have a particular reason for doing otherwise. Refer to Appendix D - Using 
the Osprey Video Capture Driver with Other Drivers for more detailed 
information about this message. 
If another kind of audio capture device such as a soundcard is already installed 
on your system, a message similar to the one above displays asking, “Do you 
want to make this your primary audio capture driver?” 

 

11. Click No to continue using your soundcard as your primary audio recording 
device. 

The Setup Complete window displays. 

12. Click Finish. 
13. Restart Windows NT. 

 
To change your setup at a later time, see Chapter 7 - Capturing Audio. 
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Testing the Installation for Windows NT  

1. Verify that the hardware installation is complete according to the directions in 
Chapter 2 - Osprey-540 Hardware. 

2. Connect a video signal source to one of the Osprey-540 connectors 
(Composite/S-video/SDI/DV). 

3. Open the Osprey-540 group in the Start menu. 
4. Click the VidCap32 icon. 
5. If your input is composite video, the screen displays a preview mode window 

with live video. Click the Overlay button. The screen should display moving 
video frames. If your input choice is not composite video, select the Video 
Source option under the Options menu. This brings up the Osprey-540 video 
capture driver configuration box where you select your video input. 

6. If the video area does not contain video, it could be for one of the following 
reasons: 
a. The driver is looking for video on the wrong input connector. You can either 

move the video cable to another connector or reconfigure the driver using 
its Control Dialog. See Chapter 6 - Osprey-540 Video Control Dialog. 

b. The video source is not turned on or activated. 
7. If the video area is scrambled or has bad color, the signal format of your video 

source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL equipment 
always need to change the driver’s signal format the first time they run the 
driver. See Chapter 6 - Osprey-540 Video Control Dialog.  

Uninstalling the Software  

If you need to remove the Osprey driver from your system: 

1. Open Control Panel. 
2. Double-click Add/Remove Programs. 
3. Click the Install/Uninstall tab. 

4. Click to select the Osprey-540 Driver in the list of programs. 
5. Click Add/Remove. 

The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete. 
8. Please reboot your computer to finish removing the driver. 

 

You have the option of deactivating the Osprey drivers without 
permanently uninstalling them. For example, this option allows you to use 
another device as your primary video capture device. Refer to Appendix 
D - Using the Osprey Video Capture Driver with Other Drivers for 
more information. 
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Chapter 6 - Osprey-540 Video Control 
Dialog 

Accessing the Dialog 

General Features of the Dialog 

The easiest way to become familiar with the video capabilities of the Osprey-540 
cards is to run the included video capture application VidCap32 and look at its menus 
and dialogs. Chapter 8 - VidCap32 focuses on the underlying video capture driver 
and the control dialogs that you can access from VidCap32. 

The Osprey-540 video capture driver has a unified tabbed dialog for setting up all 
driver parameters. There are six pages within the dialog: 

The Source Page 

The Format Page 

The Closed Caption Page 

The Configuration Page 

The Advanced Features Page 

The Logo Page 

The SimulStream Page (described in detail in the SimulStreaming User's Guide) 

The menu selections Options -> Video Source and Options -> Video Format 
access the Control Dialog's Source and Format pages, respectively. 

The selection Options -> Video Display accesses the Closed Caption page.  

Accessing the Dialog  

The normal way to access the dialog is through a menu entry or control button 
belonging to the application program. For example, VidCap32 offers the following 
three menu entries for accessing the dialog: Options > Source, Options > 
Format, and Options > Display. Once you are in the dialog, you can move to any 
other page by clicking on its tab. For example, to access the Configuration page from 
an application, open the Source, Format, or Display (Closed Caption) page and click 
the Configuration tab. 
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Another way to access the Configuration page under Windows NT is through the 
Control Panel using the following command sequence: 

1. Open the system control panel and Multimedia. 
2. Click the Devices tab. 
3. Open Video Capture Devices. 
4. Highlight Osprey-540 Video Capture Driver. 

5. Click Properties. 
6. Click Settings. 
Another way to access the Configuration page under Windows 2000 is through the 
Control Panel using the following command sequence: 

Steps:  

1. Open the system control panel and Sounds and Multimedia. 
2. Click the Hardware tab. 

3. Highlight Legacy Video Capture Devices. 
4. Click the Properties button. 
5. Click the Properties tab. 
6. Highlight Osprey-540. 

7. Click the Properties button. 
8. Click the Settings button.  
To access the Configuration page under Windows XP:  

1. Open My Computer -> Control Panel -> Sound, Speech, and Audio 
Devices. 

2. Click Sounds and Audio Devices. 
3. Click the Hardware tab. 

4. Select Legacy Video Capture Devices. 
5. Click Properties. 
6. Click the Properties tab. 
7. Select Osprey-540 Video Capture Driver. 

8. Click Properties. 
9. Click Settings. 
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General Features of the Dialog 

These are the common elements found on all pages of the dialog.  

 

OK 

Cancel 

Restore Defaults 

Restore Previous 

Apply to All Boards 

Help 

OK 

The OK button exits the dialog, saving the settings you have currently chosen. If you 
have made changes on two or more pages of the dialog, or for two or more boards, 
all of these changes are saved.  

Cancel 

This button exits the dialog box without saving any changes. If you have made 
changes on two or more pages of the dialog, or for two or more boards, all of these 
changes are discarded.  
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Restore Defaults 

This button restores the settings on the current page, for the currently selected 
board only, to the way they were when the Osprey software was installed.  

Restore Previous 

This button restores the settings on the current page, for the currently selected 
board only, to the way they were at the start of the previous dialog session.  

Help 

Clicking Help accesses the pages of this manual covering the currently selected tab.  

The Source Page 

Use the Source page to set the characteristics of the input video. 

 

Input 

Video Standard 

Video Settings 

Bypass Color Correction 
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Input 

The Input field has buttons for the card’s Composite, S-Video, SDI and DV input 
connectors. 

If Preview or Overlay mode is enabled in your application, you can usually see the 
results of your selection immediately without exiting the dialog. However, if you 
switch between inputs that have two different signal formats, such as NTSC or PAL, 
the video does not display correctly until you exit the dialog.  

Video Standard 

Video Standard or Signal refers to whether the video signal format is NTSC, PAL, or 
SECAM. The Osprey-540 supports only NTSC-M and PAL-B,D,G,H,I formats.  
Depending on the exact product version you have, buttons for some or all of the 
following formats are displayed: 

♦ NTSC-M – North America 
♦ PAL-B, D, G, H, I – many countries in Europe and elsewhere. B, D, G, H, and I 

refer to five nearly identical subformats. 
The following three standards are not supported by the Osprey-540 at this time.  
However, there are other Osprey video capture boards that do support these 
standards.  Please visit the web site at http://www.ospreyvideo.com/for more 
information. 

♦ NTSC-J – Japan 
♦ PAL-M – Brazil 

♦ PAL-N, NC – Argentina, Paraguay, Uruguay 
Full-sized NTSC-M, NTSC-J, and PAL-M have 525 lines total, 480 lines visible, per 
frame and a display rate of 60 fields per second, or 30 interlaced frames per second. 

Full-sized PAL (other than PAL-M) and SECAM have 625 lines total, 576 lines visible, 
per frame and a display rate of 50 fields per second, or 25 interlaced frames per 
second. 

The standard frame sizes are different for NTSC and PAL. For example, the half-
frame size in pixels is 320x240 for NTSC, and 384x288 for PAL. If you have selected 
a standard frame size (Full, 1/2, 3/8, or 1/4), the driver automatically adjusts the 
frame size to correspond to the standard. If you have created a custom size, it does 
not change when you switch between NTSC and PAL/SECAM. 

Changes to the standard controls do not take effect until you exit the dialog.  

http://www.ospreyvideo.com/
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Video Settings 

These four slide controls set Brightness, Contrast, Hue, and Saturation. These 
settings are stored separately for each video source. 

NOTE: When using these controls, be sure that the preview mode or overlay mode is 
enabled, so that you can immediately see the effects of your changes. 

When a video source with PAL signal format is used, the Hue setting is not adjustable 
and the Hue control is grayed out. 

When using a digital source (SDI or DV), the Brightness, Contrast, and Saturation 
settings affect encoded video.  The Hue setting is not adjustable on SDI and DV 
video sources. 

The Restore Previous or Restore Defaults button can be used to restore the previous 
video settings.  

Bypass Color Correction 

Check Bypass color correction to turn off all saturation, contrast, and brightness 
conversion in hardware and pass  digital video data directly to the host. This is most 
useful for the SDI and DV input sources. This checkbox applies ONLY to digital video 
sources. 
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The Format Page 

Use the Format page to set the color format and size of the image. 

 

Color Format 

Video Size 

Custom Size 

Proportions (Pixel Aspect Ratio) 

Cropping (please see the CropApp Manual for detailed instructions on using this 
feature) 

 



Chapter 6 - Osprey-540 Video Control Dialog 

84  Osprey-540 User's Guide – Version 2.1.5 

Color Format 

The Color Format is the arrangement of data bits representing the colors of each 
pixel. For example, in the RGB15 format, each pixel of data is stored as 5 bits of red, 
5 bits of green, and 5 bits of blue color information. 

Video delivered by the Osprey board to the system is in uncompressed format. It is 
possible to compress the video at a subsequent stage of processing. However, this 
dialog field refers specifically to the uncompressed raw video that the board delivers 
to the system. 

The color format you choose applies to Captured video and to Preview video. It does 
not apply to Overlay video. Overlay video is always matched to the display adapter’s 
current screen format - except when greyscale mode is selected. Overlay video is 
therefore as fast and efficient as possible, but the color rendering may differ very 
slightly from what you capture. Preview mode renders colors exactly, but it is slower 
and consumes more system resources. 

Changes to Color Format take effect only after you exit the dialog. 

For a more detailed description of the color modes available, refer to Appendix B - 
Color Modes. 

Video Size 

The Video Size field allows you to select between the various sizes given below. 
Changes made to Video Size take effect only after you exit the dialog. 

Size Width x Height Also known as: 

Full 640 x 480  

1/2 320 x 240 CIF 

3/8 240 x 180  

1/4 160 x 120 QCIF 

The width and height shown are in pixels for the North American NTSC-M video 
format in the square (standard) aspect ratio. For further details, refer to Appendix 
C: Video Sizes. 

There is a fifth button, Custom, that becomes selected whenever a non-standard 
size is entered in the Custom Size field. See Proportion (Pixel Aspect Ratio) for 
more detailed information.  
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Custom Size 

The Custom Size field allows you to set customized width and height values different 
from the standard preset values of full, 1/2, 3/8, and 1/4. 

If the Fixed Ratio box is checked, when you enter a new size in either the height or 
width box, both dimensions are adjusted proportionately. If this box is unchecked, 
the height and width may be entered independently. If the dimensions are different 
from normal screen proportions, the image is stretched horizontally or vertically. 

The Osprey video hardware is not capable of drawing all possible widths. Depending 
on the color mode selected, it may require a width that is an even number of pixels 
or, for YVU9 and YVU12, a width that is a multiple of 16. The dialog lets you enter 
numbers that the hardware cannot utilize, but adjusts them as soon as you click on 
another field or button of the dialog. 

See Proportion (Pixel/Aspect Ratio) for more detailed information.  

Proportion (Pixel Aspect Ratio) 

This dialog allows you to select between "Standard" (also called a Square aspect 
ratio) and "CCIR601" aspect ratio. 

The maximum resolution of the CCIR601 mode is 720 pixels for both NTSC and PAL. 
The Standard/Square aspect ratio mode has a maximum resolution of 640 pixels for 
NTSC and 768 pixels for PAL. However, the inputs to the Osprey-540 all operate in 
the CCIR601 mode. The CCIR601 format is true of the analog inputs as well unless 
the Osprey-100 Analog Mode is selected. Thus, it is recommended that only the 
CCIR601 mode be used on the Osprey-540. 

Note that since the sources are processed in a CCIR601 format, the full 768 pixels of 
the standard/square aspect ratio mode of PAL is not available. Only 720 maximum 
pixels are available. If the standard/square aspect ratio mode is selected for PAL, the 
Osprey-540 drivers limit the maximum resolution to only 720 pixels. 

Also, many digital sources provide only 704 true pixels and not 720 pixels per line. 
Because of this, the Osprey-540 scales down from 704 pixels (i.e., a crop of 720 to 
704) to the desired size. If 720 pixels are desired, for example, the result is an 
unscaled 720 pixels in width. If 704 pixels are desired, the result is an unscaled 704 
pixels in width. If 352 pixels are desired, the result is a scaling from 704 down to 
352 pixels in width (and not 720 down to 352).  

Cropping 

Please see Cropping and Scaling in this guide and also in the CropApp Manual for 
detailed instructions. 
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The Closed Caption Page 

Use the Closed Caption page to enable or disable Closed Captioning and to control its 
characteristics. 

 

Display on Screen 

Save to File 

Mode 

Channel 

Text Color 

Apply to All Boards 

Closed Captioning is a method of encoding and displaying text such as movie dialog 
captions or stock quotes as part of NTSC video. The text is similar to movie subtitles 
in appearance. Closed Captioning is widely available on broadcast video, cable, 
videotapes, and videodisks. 

The Osprey-540 video driver provides a complete implementation of the Closed 
Captioning standard and special extensions that are made possible by the capabilities 
of a PC. At the moment, the Osprey-540 only provides support for Closed Captioning 
on the analog video inputs. For more information, see No Closed Captions on Digital 
Video in Section 8 - Troubleshooting. 

You can use Closed Captioning whenever the following conditions are met: 
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♦ You must be viewing a videotape, videodisc, or broadcast material that has 
Closed Captioning content. Look for a small “CC” logo on the packaging or in 
the program listing. 

♦ Closed Captioning is for North American NTSC video only, not for PAL video. 
♦ Closed Captioning must be enabled in the Osprey driver, using the Closed 

Caption dialog page as explained above. 

♦ Video Mode and Channel 1 must normally be selected as explained above. 
You might use Text Mode or Channel 2 in specialized instances. 

♦ In addition to the normal options of viewing or capturing Closed Captioning, 
you have the special capabilities to save the text to file as you view or 
capture it.  

Display on Screen 

The Enable checkbox enables display of Closed Captioning on the screen if it is 
checked and disables it if it is unchecked. Closed Captioning currently only is enabled 
for analog (Composite/S-Video inputs). 

If you check or uncheck the Enable checkbox while Overlay or Capture mode is in 
effect, the change does not take effect until Overlay or Capture is stopped and 
restarted. 

It is recommended that you disable Closed Captioning when using non-Closed 
Captioned video. If you leave Closed Captioning enabled, the software attempts to 
interpret regular video as Closed Captioning character codes, and may sometimes 
display spurious characters. It also slightly increases the driver’s CPU usage. 

The normal display mode is Over Video. In this mode the Closed Captioning is 
superimposed on the video field. 

The Own Window option is a special proprietary mode for Closed Caption display. A 
separate window displays, and the text scrolls up in this window instead of appearing 
on the video field. This window disappears while you are capturing video and 
reappears after capturing video. This mode may be useful for some kinds of material, 
as the lines of text are not erased as quickly. The Own Window option, however, 
does not fully conform to Closed Caption standards, especially with regard to line 
placement. It may therefore give undesirable results with some kinds of highly 
formatted captions.  
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Save to File  

A nice feature of Closed Captioning on a PC is that you can save the captions to a file 
for later review. The Save to File field contains three controls: 

1. If checked, the Enable checkbox enables saving to a file. 
2. The Edit Box allows you to designate a file in which the captions are saved. 

3. The Browse button accesses a standard system dialog for locating a directory 
and file in which the captions are saved. When you choose a file that already 
exists (either by entering the file name or using the Browse button), new 
captions are appended to whatever was previously in the file. 

You may enable saving to a file without enabling display of Closed Captioning on the 
screen; the two checkboxes are independent.  

 

When SimulStream is in use, only one closed caption session is available 
to save to a file. 

Mode 

Video is the normal Closed Captioning display mode used with almost all videos and 
broadcast TV. Text is a specialized mode in which the entire 32 character by 15 row 
Closed Captioning area of the screen is blanked and used to display text. Use Video 
mode unless you know specifically that the material is Text mode.  

Channel 

Channel 1 is the channel normally used in almost all Closed Captioning. Some 
specialized material may use Channel 2. 

 

Note that with most material, if you select Channel 2, you won’t see any 
Closed Captions. 

Text Color 

The default appearance of captions is white text on black background.  You can 
select the foreground text color to be one of six other colors here. 
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Apply to All Boards 

If multiple boards are installed, changes can be applied to all of the installed boards 
simultaneously.  If you only want to apply the changes to the selected board, do not 
select the Apply to All Boards check box. 

The Logo Page 

 

The Osprey Video Capture Driver allows you to superimpose a logo on captured 
video, as in the images above. The “VCST” logos shown illustrate some of the 
features for color keying and translucency that are described below. 

Use the setup dialog’s Logo page to set up a logo. The logo page is actually a 
sequence of five pages that guide you through the steps of creating a logo and 
placing it on the video. 

You cannot access the Logo page directly from most applications. Instead, open the 
Source or Format page of the dialog, then click on the Logo tab. 

Capabilities 

Step 0 - Before You Start 

Step 1 - Creating and Enabling the Logo 

Step 2 - Selecting the Logo File 

Step 3 - Setting Key Color and Style 

Step 4 - Positioning the Logo 

Step 5 - Reviewing and Saving the Changes 

Notes on Logos 
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Capabilities 

A logo can be any artwork that is formatted as a 24-bit BMP file. Typically, a logo is a 
small graphic that is placed at the lower left of the image. In a technical application, 
however, a logo could be a crosshair pattern placed at the center of the image. The 
logo can theoretically be any size. However, the CPU must actively draw the image 
on every frame of video, and drawing a very large image, even if it is mostly 
transparent, degrades overall performance in high-throughput applications. 

The driver can draw a logo on captured or streaming video, on preview video, or on 
DibDraw overlays. However, the driver cannot draw a logo on DirectDraw overlays. If 
you attempt to draw a logo on DirectDraw overlays, everything appears to work fine, 
except that the logo is not visible. 

A logo’s rectangle can be partially transparent so that the underlying video is visible. 
The transparent areas are defined by a Key Color – a particular (red, green, blue) 
value that is specially interpreted by the driver. For example, the sample logos use 
cyan with red, green and blue values of (0, 128, 128) as the key color. 

A logo displays in either of two styles – normal and embossed. In normal style, the 
logo’s non-transparent pixels simply replace whatever video underlies it. In 
embossed or translucent style, the logo's non-transparent pixels are averaged with 
the underlying video pixels, resulting in a more subtle effect. 

For detailed instructions on setting up a logo, review the following steps: 

Step 0 - Before You Start 

Step 1 - Creating and Enabling the Logo 

Step 2 - Selecting the Logo File 

Step 3 - Setting Key Color and Style 

Step 4 - Positioning the Logo 

Step 5 - Reviewing and Saving the Changes 

Step 0 - Before You Start 

Create your artwork with the Windows Paint application or any other paint program 
that you like to use. Save it in 24-bit BMP format. 

Before creating your own logo, however, you may want to experiment with the 
samples supplied with the driver. They are located in the Osprey program directory, 
by default \Program Files\Osprey 540\Nt on the default drive. 

Have Preview or DibDraw Overlay mode running when you enter the dialog to see 
immediately the results of interactively defining and placing the logo. DirectDraw 
Overlay mode does not work for this purpose. To change from DirectDraw to 
DibDraw,– or to find out which one you are currently using – go to the dialog’s 
Configuration tab, then stop and restart Overlay mode.  



 Chapter 6 - Osprey-540 Video Control Dialog 

Osprey-540 User's Guide – Version 2.1.5  91 

Step 1 - Creating and Enabling the Logo 

Additional links: 

The Logo Page 

Capabilities 

 

As you can see, the logo setup pages include detailed explanations at each step. 

The first page handles only one consideration – whether logo drawing is enabled or 
not. 

By default, the Enable box is not checked and therefore no logo displays. In this 
case, when you click Next>> you go directly to the last page (page 5) of the logo 
setup sequence. 

If the Enable box is checked, you can click Next>> to step through all of the pages 
of the setup sequence.  
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Step 2 - Selecting the Logo File 

Additional links: 

The Logo Page 

Capabilities 

 

 

This screen should be nearly self-explanatory. You are selecting a BMP file, either 
your own artwork or one of the samples. You can type in the full pathname to the file 
or browse for it. When you have selected the file, click Next>>. 

The sample logos are located in the Osprey program directory, by default \Program 
Files\Osprey-540\Nt on the default drive.  
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Step 3 - Setting Key Color and Style 

Additional links: 

The Logo Page 

Capabilities 

 

As previously noted, a key color is a (red, green, blue) color value that the driver 
treats specially. Logo pixels in that color do not display; the underlying video 
displays instead. This dialog sheet lets you choose one of four fixed key colors, or no 
key color. If you select None for the key color, all pixels from the logo display 
including all pixels in any of the key colors. 

A key color must be a precise (red, green, blue) value. For example, if cyan is 
selected as a key color the pixel values must be exactly (0, 128, 128). A pixel of 
value (0, 127, 127) does not display transparent – it displays as cyan. 

All four key colors are standard stock colors in Windows Paint. 

If the Embossed box is checked, each pixel color value displayed is the average of 
the pixel value of the logo and the pixel value of the underlying video. If Embossed 
is not checked, the pixel color value is simply the value from the logo. 

The key color setting takes precedence over the Embossed setting; that is, logo 
pixels in the key color are transparent, not averaged, even in Embossed style.  
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Step 4 - Positioning the Logo 

Additional links: 

The Logo Page 

Capabilities 

 

The Position control allows you to position the logo by dragging it with the mouse. 
The Nudge controls move the logo up, down, left or right one pixel at a time. They 
permit more precise adjustments than the Position control can achieve. 

If Preview or DibDraw Overlay video is running, the logo moves on the video as you 
move it in the dialog. 

If you position the logo in a certain way and then change the video size, the driver 
stretches the logo to maintain the same relative size, and places it in the same 
relative position. The stretched artwork may have jagged diagonal edges and not 
look as good as unstretched artwork prepared with the intended video size in mind.  
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Step 5 - Reviewing and Saving the Changes 

Additional links: 

The Logo Page 

Capabilities 

 

This page shows a text summary of the current logo configuration. 

If you have multiple boards in the system, a checkbox entitled Apply to all Boards 
is shown. If you check this box, the logo changes you make to the current board are 
made to all the boards in the system. 

 

If you have multiple boards in the system and the only change you make 
is to enable or disable logos, clicking OK with Apply to All Boards 
checked changes the enable/disable status of all boards but doesn't 
change any of the other settings. If, however, you make any logo 
changes other than enable or disable, Apply to All Boards copies the 
entire current configuration to all boards. 
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Notes on Logos  

If you set up a logo with video set to one size, then resize video, the logo is scaled 
correspondingly. For example, if the logo is originally set up for 320 x 240 video, and 
you change to 640 x 480 video, the logo displays at twice the size of the original 
bitmap. 

1. If you edit the logo settings while the logo is scaled up or down, an additional 
option entitled Rescale displays after Enable. 

 

If you click the Rescale button on this page, the logo is resized to the same 
size as the original source bitmap. 

If you do not click the Rescale button, you can edit the logo settings using the 
scaled logo. Even if you change to another bitmap image, the old scaling is 
maintained. 

2. The driver can display color logos on YUV video – 4:2:2 packed, YUV12 planar, 
and YVU9 planar. The appearance may not be quite the same as the RGB 
version, however. 

3. Detail of colored features may not be as crisp, because in the YUV modes color 
is not sampled at full pixel resolution. 

 

DibDraw Overlay video is always RGB even when you have selected a YUV 
color format in the dialog. Preview video is always in the exact YUV or 
RGB format you have selected. Therefore, when using a YUV mode be 
sure to check the appearance of the logo in Preview mode before putting 
it to use. 

4. When Grey8 video format is selected, all logos including color logos are 
displayed in greyscale.  



 Chapter 6 - Osprey-540 Video Control Dialog 

Osprey-540 User's Guide – Version 2.1.5  97 

Apply to All Boards 

This option displays on relevant dialog windows when more than 1 Osprey card is 
installed in a system.  The only dialog window tabs that can apply an operation to 
multiple boards are Closed Caption and Logo. The settings for all the boards are 
saved when you click OK; or all are discarded if you click Cancel. 

The Advanced Features Page 

Select a link below the screen for more information. 

 

The Transfer Mode 

The De-Interlacing Motion Filter 

Field Order 

Field Order 

The Osprey-540 allows you to configure which pairing of fields will be used to 
construct a frame. For interlaced capture devices (most current video cameras) the 
field order does not matter and the 'Allow Either' setting will provide better 
performance in VFW preview mode. The default setting for this feature is 'Allow 
Either'. Use the force odd-even or force even-odd settings with a progressive scan 
camera. Consult your camera's technical documentation for the correct setting to 
use. Using the correct setting with a progressive scan camera will eliminate comb-
like interlacing artifacts. 
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The De-Interlacing Motion Filter 

The Osprey-540 offers software de-interlacing. This feature is optimized for Windows 
2000 and later; it will consume fractionally more CPU cycles when enabled under 
Windows NT.  Most video is provided for viewing in an interlaced format. For 
simplicity, NTSC is used in the following explanation of an interlaced format. NTSC 
video is basically composed of images taken 60 times a second. Each image is called 
a field, and there are odd and even fields. While these odd and even fields are 
temporarily adjacent to each other in time, the horizontal lines that make up these 
fields are spatially different. 

 

The figure above is a simplistic view of interlaced video and fields. The two fields are 
taken 1/60th of a second apart, and the lines of each field are not aligned, but 
staggered. Most televisions are interlace display devices, where the 60 fields are 
displayed individually and the viewer sees only one field at a time. However, most 
computer monitors are progressive and not interlaced display devices. On a 
computer monitor where video is viewed at its full resolution, viewers see both the 
odd and even fields at once: 

 

The problem with progressive display devices is that if an object is moving, its 
position is not the same in both the odd and even fields. When odd and even fields 
are merged together, interlaced artifacts occurs. The artifacts are seen and 
commonly described as streaking or feathering. 
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The screen above illustrates the streaking or feathering problem that occurred when 
the interlaced odd and even fields in this video were captured. Only a slight amount 
of motion took place, yet streaking is obvious in the overall result. Note the 
prominent horizontal lines outlining all the objects on this screen. 

When feeding such images to an encoder, the encoder has a significantly harder time 
processing and compressing such interlaced video. The result is loss of overall quality 
and perhaps a loss of frame rate as well. While the encoding process may smooth 
out some of these artifacts, the resultant compressed video may still display 
somewhat streaked or feathered and may not play back smoothly. 
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The Osprey-540’s de-interlacing motion filter can be applied to any video source 
after to the optional scale and color-convert phases of processing to eliminate 
streaking or feathering and maintain motion content. In the screen above, where the 
Osprey-540’s de-interlace motion filter has been turned on, note that the strong 
horizontal streaking or feathering around the subject’s head have been smoothed to 
a slight blur. While the blur is noticeable in a single screen snapshot, the human eye 
perceives only natural motion when the video is played back at normal frame rates. 

Feeding the de-interlaced image in the screen above to an encoder significantly 
improves output of the encoder in terms of overall quality and smoothness. The 
encoder has an easier time compressing the de-interlaced video and thus can expend 
saved bits and CPU cycles to produce higher quality streams.  

The Transfer Mode 

The Osprey-540 captures video data to the host or to the display device via two 
different transfer modes. The first mode, Odd/Even, transfers video such that the 
odd lines of video are grouped together before the even lines. If the video source 
was interlaced to start with and the hardware de-interlacing filter was not applied, 
the Odd/Even mode basically places the odd field on top of the even field. If the de-
interlacing filter was applied (see description further down), this mode places the odd 
lines of the resultant de-interlaced frame before the even ones. The Odd/Even 
transfer mode only occurs when the resolution is greater than half the maximum 
resolution (>240 for NTSC and >288 for PAL).  

The second mode, Interleaved, transfers video vertically in line order. For example, 
line 1, line 2, line 3, etc. Basically, this is an interlaced mode. However, since the 
video source may have been progressive to start with, or because the de-interlacing 
filter may have been applied, the term ‘interlaced’ transfer mode is inappropriate. 



 Chapter 6 - Osprey-540 Video Control Dialog 

Osprey-540 User's Guide – Version 2.1.5  101 

The following images further describe the Odd/Even and Interleaved transfer modes: 

 

The first image is a snapshot of video captured using the Interleaved transfer mode. 
The source is an interlaced DV camera, and the image size is 640x480. 

 

The second image is a snapshot of video captured using the Odd/Even transfer 
mode. The source is an interlaced DV camera, and the image size is 640x480. 
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The third image is a snapshot of video captured using the Odd/Even transfer mode. 
The source is an interlaced DV camera, and the image size is 320x480. This mode of 
capture can be used to acquire video at 60 fields/sec. The Osprey-540 already 
horizontally scaled the video down to 320 pixels in width in hardware. Having the 60 
fields/sec delivered 30 times a second in the format given here offers the advantage 
of keeping the odd/even pairing of video consistent in the case of capture loss due to 
performance of the application.  
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The Configuration Page 

The Configuration page controls several miscellaneous settings.  

 

Overlays 

Access to Format Tab 

Multiple Opens 

Default Capture Device 

Overlays  

Direct Draw is a fast drawing method that moves video directly from the Osprey 
capture card to the display adapter. If Use Direct Draw is selected, the driver uses 
Direct Draw for Overlay drawing. If for some reason it cannot use Direct Draw, it 
automatically defaults to DibDraw. 

Direct Draw works with the vast majority of display adapters and software driver. We 
recommend running with Direct Draw enabled unless you are having a problem 
viewing overlay video, or want to use the “doubled lines” option discussed below. For 
more details on Direct Draw, refer to Appendix E - Direct Draw. 

DibDraw is the default drawing method. Video is moved first into system memory 
and copied to the display adapter. It is useful in the following cases: 

1. For systems where Direct Draw does not work correctly. 

2. If you want to enable “line doubling”. When DibDraw is selected, two radio 
buttons are enabled that let you choose between interlaced and line-doubled 
video. 
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Normally, video larger than ½-height (240 lines NTSC, 288 lines PAL) is interlaced. 
NTSC and PAL video both consist of alternating odd and even fields of data. Odd 
numbered lines come from the odd fields, even numbered lines come from the even 
fields. 

Interlaced video offers maximum resolution but suffers from a “comb” effect. When 
there is rapid motion in the video, it displays blurred. It is recommended for still or 
slow-motion video, but may not look good with high-motion content. 

Line-doubled video uses video data from only one field. Each video line is copied to 
two lines of your display. Line-doubling reduces the still-picture resolution by half; 
however, it eliminates the “comb” effect of interlaced video and is therefore useful 
for viewing rapid-motion video. 

3. If you want to stretch the video on your screen beyond full size (640x480 
NTSC, 768x576 PAL). You would need a special application to do this. DibDraw 
video can be stretched but Direct Draw video cannot be.  

Access to the Format Tab 

The two options are: 

♦ Prevent access to a dialog’s format tab via source dialog 
♦ Allow this access 

Video for Windows applications access the Source and Format pages as separate 
commands and do not assume that the driver allows you to switch from one to the 
other. 

Some applications, when they access the Source page, do not check to see if you 
also made changes to items in the Format page. The result is that the application 
and the driver may assume different settings and not work properly together. 

This control in its default “prevent access” setting prevents you from entering the 
Source page or Closed Caption page, switching to the Format page, and 
inadvertently making changes that the application cannot pick up. It also disables 
the Board Select control on the Source and Closed Caption pages since the driver 
maintains separate format information for different boards. The “prevent access” 
setting is recommended for maximum compatibility with all applications. 

The “prevent access” settings is, however, inconvenient. The alternative setting to 
“allow this access” allows you to switch between pages without restriction. This 
works with many applications; however, the responsibility lies with you to make sure 
no problems arise.  

Multiple Opens 

We recommend keeping this box checked unless you have a reason not to. This 
ensures compatibility with the greatest number of present and future applications 
that you might want to use. 
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If Multiple Opens is checked, a particular board can be opened for access from 
multiple places, either within a single process or by multiple processes. However, the 
features available through subsequent opens are limited. This mode is needed by 
certain complex applications that, for example, use separate processes for capture 
and overlay. 

If Multiple Opens is unchecked (hunt mode), a particular board can be opened for 
access from only one place in one process. If there are multiple boards in the 
system, and an application tries to access a board that is already in use, the driver 
hunts for the next available board. This is the easiest way to start multiple copies of 
Windows Media Encoder or VidCap32, for example, to view multiple video inputs. 

Changes you make take effect when you click OK to close the dialog. Applications 
such as VidCap32 do not pick up changes until you restart them. 

Review Appendix F - Multiboard Installations for more information. 

Default Capture Device 

This control is useful if you have multiple video capture devices of different kinds. 
These could include cards from other vendors or different kinds of capture cards from 
Osprey. In this context, the Osprey-50, -100, -101, and -200 are considered one 
single device type. The Osprey-540, Osprey-500, the Osprey-1000, and the Osprey-
2000 are each separate device types. 

Some applications are capable of accessing only the primary or default device. With 
this control you can select which device is the default device applications use. 

Changes you make are written to the registry when you click OK to close the dialog. 
Applications such as VidCap32 does not pick up changes until you restart them. 
Some DirectX-based applications may not detect changes until you restart the 
system.  

The SimulStream Page 

SimulStream is an added-cost upgrade option described in detail in the 
SimulStreaming User's Guide – Revision 1.1. 
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Cropping and Scaling 

The Osprey video capture driver package includes the capability to crop the incoming 
video signal in hardware before it is encoded or captured. Cropping is done by the 
Osprey card and imposes no extra load on the host computer. Use any of the 
following methods to crop the incoming video signal: 

♦ Video Format dialog box 
♦ CropApp, the cropping application 
♦ SDK 

Please see the CropApp Manual which is installed in the Osprey-540 Program group 
for details on using this feature. 
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Chapter 7 - Capturing Audio 

Setup and control for audio are much simpler than for video. The basic steps are 
covered in the following topics:  

Select the Audio Source and Input Volume 

Registry Settings Controlling other Audio Parameters  

Audio Formats 

Missing Digital Audio Sources 

Audio Playback 

Note for DV users: 

The Osprey-540 is capable of converting sampling rates from a higher sampling rate 
to a lower sampling rate. For instance, if you set your DV audio to 48 kHz, the card 
can provide all common sampling rates (48 kHz, 44.1 kHz, 32 kHz, 22 kHz, 16 kHz, 
11 kHz, 8 kHz). If your DV audio is set to 32 kHz, the Osprey-540 driver can convert 
to higher sampling rates. 

Note for DVD users playing CD audio: 

If you are playing a CD in a DVD player, the Osprey-540 is able to capture at all 
sampling rates including 48 kHz. This is because the Osprey-540 driver can convert 
audio from a lower sampling rate to a higher sampling rate. 

Selecting the Audio Source and Input 
Volume  

The audio source is set using the Osprey-540’s VFW mixer driver interface. Some 
applications interface to the mixer driver directly and expose the look and feel 
specific to that application. However, there is a DirectShow based mixer interface 
that does not work with the Osprey-540's VFW mixer. If you are having problems 
setting mixer settings (audio ports or gains), please contact support@viewcast.com 
and we'll help you resolve that issue. 

The default Windows interface to the mixer driver can also be used and is the 
recommended way to set audio ports and gains on the Osprey-540. There are two 
simple methods for getting to the mixer source and volume control dialog box. 
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1. The easiest method for accessing this interface is to right click the speaker 
symbol on your taskbar (typically on the bottom right-hand side of your 
screen). Then select the Open Volume Controls option. 

2. If you do not see the speaker symbol, click the Start button on the Start Menu, 
select Programs->Accessories->Entertainment (or Multimedia) and 
select Volume Control.  For Windows XP, select Start -> All Programs -> 
Accessories -> Entertainment -> Volume Control. 
Either of these two methods brings forth the audio mixer interface for the audio 
playback device. To get to the Osprey-540 audio capture (recording) device, 
select Properties under the Options menu. This pops up a dialog to select 
the Mixer device. Do not select the Recording option within the Adjust 
Volume for section; this option is selected automatically when you select the 
Osprey-540 for the mixer device. Click on the dropdown list for Mixer device 
to see the list of audio input and output devices, including the Osprey-540. 

 

If more than one Osprey-540 card is in the system, each Osprey-540 card is 
enumerated individually. Once an Osprey-540 device has been chosen, select 
OK in the Properties dialog box. 
The Osprey-540 Master Control panel displays. 

 

The Osprey-540 device is not a mixer in that it does not allow for mixing the various 
audio sources. Therefore, when one audio input is selected, any other input 
previously selected becomes unselected. The Select checkbox at the bottom of each 
source sets which source is actually being used.  DV audio signals are embedded in 
DV video signals.  If you select DV audio, the video signal selection for PAL/NTSC 
must match the state of the DV source. 
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The Osprey-540 device is not a mixer in that it does not allow for mixing 
the various audio sources. Therefore, when one audio input is selected, 
any previously selected input is unselected.   

When you are capturing audio, the vertical field in the Record Control Volume section 
will light up with green, yellow, and red bars (like sound meters on home audio 
equipment). 

The Osprey-540 card has a hardware gain on the analog audio inputs. To control 
the hardware gain for the card, use the volume slider in the mixer applet. The 
Osprey-540 card has a software gain control on the digital audio inputs. For 
instructions on changing the software gain (for digital sources only), refer to Gain 
Selection.   

The Osprey-540 provides external monitoring of the audio input.  The audio output is 
a stereo unbalanced RCA connector. There is no gain or attenuation control for the 
audio-out monitoring feature. You cannot change the balance or volume controls on 
the Osprey-540 playback device in the mixer applet. 

 

The quick-access volume control (left click on the speaker symbol) on 
the task bar controls playback volume and recording volume. To change 
record levels, go to Options, then Properties, and select Recording. 

Registry Settings Controlling other Audio 
Parameters 

The Osprey-540 mixer applet does not provide a mechanism for setting all of the 
audio capabilities. Entries in the registry control include: 

Rate Conversion Method 

Gain Selection 

Rate Conversion Method 

This feature selects the method Osprey-540 uses to convert audio from one sampling 
rate to another. For example, audio from a DV source is typically48 KHz stereo 
audio. For various reasons, you may want to capture audio at only 8 KHz. For most 
purposes, the default setting of Filter Converter works well. 

The registry values which control Rate Conversion are listed below.  The X stands for 
the device number of the Osprey-540 card. Numbering starts at 0, so the first 
Osprey-540 card is Device 0. 

HKEY_CURRENT_USER\Software\Osprey\Osprey2000\DeviceX\Audio\RateConversion 
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When Rate Conversion is: 

♦ 1 - use filter converter (default) 

♦ 2 - use skip converter (skips samples) 
♦ 3 - use Microsoft PCM method 

Gain Selection 

Gain Selection allows you to boost the audio level in software. This applies only to 
digital audio sources (AES/EBU, DV, and embedded SDI).Analog audio sources 
(unbalanced and balanced audio) have hardware gain, controlled by the volume 
slider on the mixer applet). 

The default value of 2 is sufficient for recording from most sources including 
camcorders, CD players, and Walkman radios. If you have audio sources that are at 
lower levels, increase the Gain value. The registry values which control this are 
below. The X stands for the device number of the Osprey-540 card. Numbering starts 
at 0, so the first Osprey-540 is Device 0. 

HKEY_CURRENT_USER\Software\Osprey\Osprey2000\DeviceX\Audio\Gain 

The default value of Gain is 2. Set it higher for increased software audio gain. Set it 
below 2 to decrease gain. 

Audio Formats 

The only Format that the Osprey-540 audio capture driver supports is PCM. The 
driver supports the following data rates: 

♦ 8 kHz 

♦ 11.025 kHz 
♦ 16 kHz 
♦ 22.05 kHz 
♦ 32 kHz 

♦ 44.1 kHz 
♦ 48 kHz 

These data rates are supported in 8-bit and 16-bit, mono and stereo formats. The 
actual Osprey-540 hardware supports sampling of analog audio at 32, 44.1 and 48 
kHz. Depending on the requested audio format, the Osprey-540 driver automatically 
selects the most appropriate hardware sampling rate. For example, if 22.5 kHz audio 
is desired, the audio driver selects the 44.1 kHz audio rate and down samples it to 
22.05 kHz. 

The Osprey-540 driver provides for optimal rate conversion from these base 
sampling rates. For digital sources, the sample rate has already been determined. 
The Osprey-540 automatically determines the digital audio sample rate and converts 
this as required by the application’s requested sample rate. 
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It should be noted that the Osprey-540 does not currently dynamically readjust 
sampling rates while audio capture is in progress. Thus audio capture should be 
stopped and restarted whenever the audio input port changes. 

For mono sources, the Osprey-540 uses only the left audio channel. Optionally, this 
can be configured to be the left channel or a mix of the left and right channels.  

Missing Digital Audio Sources 

Be sure to start the audio source before attempting capture. When a digital audio 
source (such as DV or AES/EBU) is selected before the audio is turned on, the 
Osprey-540 is unable to determine the sampling rate. The sampling rate is a 
measure of the amount of binary data needed to reproduce the audio being capture. 
If the audio source is not available, the Osprey-540 cannot determine the format of 
the incoming audio. 

When a capture is started before the audio source is selected, the audio may not be 
sampled at the correct rate. Audio sampled at an incorrect rate sounds slower or 
faster than normal when it is played back. Should this occur, stop and restart 
capturing audio. 

The default digital audio sampling rate is 48 kHz. Some common sampling rates are: 

♦ 48 kHz (typical for SDI) 
♦ 44.1 kHz 

♦ 32 kHz or 48 kHz for DV sources 

Audio Playback 

The Osprey-540 provides audio capture only, not audio playback. Continue to play 
back captured audio using your system soundcard.  
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Chapter 8 – VidCap32, AmCap, and 
Included Demo Programs 

The Osprey-540 Driver includes the following applications: 

VidCap32 

Playback 

AmCap 

Control Panel 

DirectXMedia Details 

Ligos Technology's Indeo 

Cropping and Scaling 

VidCap32 

 

VidCap32 is a video capture application that is included with the Osprey package. It 
is useful for testing the installation and for general purpose viewing of video. The 
following instructions take you through the basic scenarios for using this applet. Also 
see Cropping and Scaling. 
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Preview 

Overlay 

Single Frame Capture 

Configuring the Video Capture Driver 

Compression 

Setting the Capture File – Preallocating and Defragmenting 

Capturing Video 

Preview 

The Preview button (first button on the left on the toolbar) toggles Preview mode on 
and off. When Preview is enabled, the video you see is constantly updated and has 
the exact format and appearance of uncompressed video capture.  

Overlay 

The Overlay button (second button from the left on the toolbar) toggles Overlay 
mode on and off. When Overlay is enabled, the video you see is updated constantly. 
The difference from Preview is that the Osprey driver uses the fastest and most 
efficient drawing method it can. Normally, with Direct Draw enabled and working, it 
draws at the full frame rate (30 per second) with minimal processor overhead. 

Note that the Preview and Overlay buttons behave like radio buttons that cancel 
each other - you do not have to shut off preview in order to start overlay.  

Single Frame Capture 

The rightmost button on the toolbar is used to capture a single frame. Every time 
this button is selected, a single frame is captured and displayed in the window. You 
can copy this image and paste it into other applications.  

Configuring the Video Capture Driver 

You can go through VidCap32 to access the Osprey driver’s Control Dialog (described 
in Chapter 6). The menu selections Options->Video Source... and Options-
>Video Format... access the Control Dialog’s Source and Format pages 
respectively. The selection Options->Video Display... accesses the Closed Caption 
page.  
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Compression 

It is possible to compress video as it is captured to disk. Neither VidCap32 nor the 
Osprey video capture driver perform video compression themselves. However, 
VidCap32 may be connected to external software-based compression modules. 
Compression results in a much smaller capture file. The downside is that many types 
of compression are slower: you may have to reduce your frame rate in order to avoid 
dropping an excessive number of frames. With a “quick-compression” methods 
running on a fast machine, however, the extra processing time is slight enough that 
it is fully compensated for by the reduced time needed to write the more compact 
data to disk. 

When a compressor is enabled, video is passed from the Osprey capture driver to the 
compressor, which then writes it to file. The compression dialog, accessed by the 
Options->Compression menu item, allow you to select a compressor, or select no 
compression. The information below for Ligos Technology’s Indeo compressor gives a 
detailed example of how to perform this task. 

Note that the list of available compressors is different for each video Color Format 
selected in the Osprey video capture driver’s control dialog. You should therefore 
select the Color Format you are using first, then select the compressor. Otherwise, 
you may get an error message when you try to begin video capture.  

Setting the Capture File - Preallocating and Defragmenting 

The leftmost button on the toolbar (or the menu item File -> Set Capture File) 
opens the Capture File dialog box. 

Depending on a number of factors, you may experience a significant percentage of 
frames dropped. The percentage of frames dropped is a function of frame size, use 
of a compressor, and the speed of your system. Performance can be substantially 
improved by preallocating a capture file and defragmenting it. 

“Preallocating” a file means that space has been reserved for it on your hard disk. 
The menu item File -> Allocate Disk Space brings up a dialog in VidCap32 by 
which you can preallocate a file and reserve space large enough to hold the largest 
video clip that you are likely to want to capture. In AmCap, it is the menu item  
File -> Allocate File Space. You can preallocate multiple files to hold multiple video 
clips. 

For preallocation to be useful, the hard drive should be defragmented afterwards. 
“Defragmenting” a drive reorganizes its physical sectors so that each file occupies 
contiguous sectors, rather than having different parts of it scattered about the disk. 

AmCap and VidCap32 do not perform defragmentation; a third-party program is 
required. Various defragmentation programs are available commercially, and if you 
have Windows 95/98 on the system you can use its built-in defragmenter. Use 
AmCap or VidCap32 to preallocate the files, then exit to run the defragmentation 
program. 
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 NOTE: Defragment after you allocate and size the capture files. 

After the disk is defragmented, return to AmCap or VidCap32. The files you 
preallocated are now located in a contiguous areas of the hard drive. Their physical 
layout remains the same until the file is resized or deleted. 

An alternate technique that avoids the need for defragmenting is to set up a 
separate disk partition dedicated to video capture, containing a single capture file. 

Defragmenting is a time-consuming procedure, but is worth the trouble if you have 
an ongoing need to capture high-quality video, particularly uncompressed video. Be 
sure to plan the number and size of files you need. Once you have the defragmented 
files, be sure not to accidentally delete them - think of them as your permanent 
working space for time-critical operations, not as containers of specific video clips. 
Copy your clips to other files for storage and editing.  

Capturing Video 

The second button from the right opens the Video Capture Dialog. This can also be 
accessed by the Capture -> Video menu item. 

 

The dialog includes controls to set the number of frames per second, as well as an 
optional time limit (in seconds) for the sequence. Buttons are provided to access 
both the video capture driver’s configuration dialog and the compression dialog. You 
can also access and configure audio, assuming that it is installed and enabled. The 
dialog allows a choice between capturing video directly to disk, or capturing via 
memory. Note that capturing to memory may result in fewer dropped frames - but 
not necessarily. 

For best quality video capture, use a capture rate (frames per second) that is slow 
enough so that there are no dropped frames. 

Once the proper configuration is confirmed, click OK to capture the video. To end 
capture, click the mouse anywhere in the VidCap32 window.  
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Playback 

The simplest way to play back a video clip is to find its icon in “My Computer” and 
double-click on it. This starts Windows Media Player, which automatically plays the 
clip. Windows Media Player contains standard start, stop, and pause buttons and is 
largely self-explanatory. Refer to Windows Media Player’s online help for more 
information.  

AmCap 

 

AmCap is a video capture application included with the Osprey-540 package. It is 
useful for testing the installation, for general purpose viewing of video, and for 
capturing video to a file. AmCap differs from the other general purpose capture 
application, VidCap32, included with the Osprey package in that: 

♦ Because AmCap captures AVI 2.0 files, AmCap can handle captured file sizes 
that exceed VidCap32's 2GB limit. 

♦ AmCap is written using the DirectShow API; VidCap32 is written using the 
VFW API. Another application that uses DirectShow is Windows Media 
Encoder. 

♦ AmCap does not support software compression modules. 
♦ AmCap's Preview mode is equivalent to VidCap32's Overlay mode. 

♦ AmCap does not have an equivalent to VidCap32's Preview mode. 

AmCap requires the DirectX Media runtime version 6.0 or later in order to run. This 
runtime is included on this CD, and can be installed by the Osprey installation 
program. More information about DirectX Media is available at DirectX Media 
Details. 

Instructions for using AmCap are provided in the following sections. Note that this 
applet has additional capabilities and settings that are beyond the scope of this brief 
introduction. Refer to AmCap’s Help menu for a description of those capabilities and 
settings. 
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Selecting the AmCap Device 

AmCap Preview 

Configuring the Video Capture Driver in AmCap 

Setting the Capture File in AmCap - Preallocating and Defragmenting 

Capturing Video with AmCap 

Playback 

Selecting the AmCap Device 

 

AmCap requires selecting the input device(s) before you can preview or capture 
video. Use menu item Devices to show a dropdown list of the audio and video 
capture devices present. In this list, the video device portion of Osprey-540 cards 
appears as Osprey-540 Codec and the audio device on the Osprey-540 displays as 
Osprey-540 Audio. 

If you have multiple Osprey-540 cards present, you can select the audio device from 
this list. For instructions on selecting among multiple video sources, please see The 
Format Page. 

Multiple board installations are a specialized subject discussed in Appendix F: 
Multiboard Installations.  



 Chapter 8 – VidCap32, AmCap, and Included Demo Programs 

Osprey-540 User's Guide – Version 2.1.5  119 

AmCap Preview 

 

When you first start AmCap, there is nothing in the video field display. To see video, 
you must enable Preview mode by clicking on the menu item Options -> Preview. 

When preview is enabled, the video you see is updated constantly. What you see is a 
close approximation to the appearance that uncompressed video captured to file will 
have. However, with the AmCap applet preview video is optimized for fast screen 
drawing rather than the exact capture format, possibly resulting in slight differences 
in the appearance of the video.  

Configuring the Video Capture Driver in AmCap 

You can go through VidCap32 or AmCap to access the Osprey driver’s Control Dialog. 
The menu selections Options-> Video Source and Options-> Video Format 
access the Control Dialog’s Source and Format pages, respectively. The selection 
Options-> Video Display accesses the Closed Caption page. 

The recommended color format when capturing AmCap is “4:2:2packed”. This is set 
in the Format Page of the Osprey driver's Control Dialog. 

For more information about Control Dialog, refer to Chapter 6 - Osprey-540 Video 
Control Dialog.  
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Setting the Capture File in AmCap - Preallocating and 
Defragmenting 

The menu item File -> Set Capture File opens the Capture File dialog box. 

 

Since several variables can affect the percentage of frames dropped, performance 
may be substantially improved by preallocating a capture file and defragmenting it. 
The percentage of frames dropped is a function of frame size, use of a compressor, 
and the speed of your system. 

If you do not know the size of file that you are going to capture, it’s best to allocate 
a 1MB file and allow VidCap32 to dynamically allocate more space on the fly. 

Preallocating a file means that space has been reserved for it on your hard disk. The 
menu item File -> Allocate File Space brings up a dialog in AmCap or VidCap32 by 
which you can preallocate a file and reserve space large enough to hold the largest 
video clip that you are likely to capture. You can preallocate multiple files to hold 
multiple video clips. 

For preallocation to be useful, the hard drive should be defragmented afterwards. 
Defragmenting a drive reorganizes its physical sectors so that each file occupies 
contiguous sectors, rather than having different parts of it scattered about the disk. 

AmCap and VidCap32 do not perform defragmentation; a third-party program is 
required. Various defragmentation programs are available commercially, and 
Windows 2000 contains a built-in defragmenter. Use AmCap and VidCap32 to 
preallocate the files, then exit to run the defragmentation program. 

 
NOTE: Always defragment after you allocate and size the capture files. 

After the disk is defragmented, return to AmCap/VidCap32. The files you 
preallocated will now be located on contiguous areas of the hard drive and their 
physical layout will remain the same until the file is resized or deleted. 

An alternate technique that avoids the need for defragmenting is to set up a 
separate disk partition dedicated to video capture, containing a single capture file. 
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Defragmenting is a time-consuming procedure, but is worth the trouble if you have 
an ongoing need to capture high-quality video, particularly uncompressed video. Be 
sure to plan the number and size of files you will need. Once you have the 
defragmented files, be sure not to accidentally delete them. Think of these files as 
your permanent working space for time-critical operations, not as containers of 
specific video clips. Copy your clips to other files for storage and editing.  

Capturing Video with AmCap  

 

AmCap requires setting a few options before starting Video Capture. 

1. First, set the Frame Rate by selecting menu item Capture -> Set Frame Rate 

 

2. Note that the maximum NTSC frame rate is 29.97 frames/sec and not 30 
frames/sec. The maximum PAL frame rate is 25 frames/sec. If you want to 
capture at the full NTSC frame rate, set the rate to 29.97 in this menu. 

3. Capturing uncompressed video to disk is limited by disk throughput. You may 
find that your system is not capable of capturing to disk, for example, at full 
resolution full frame rate. In this case, you may be best served by reducing 
either the frame rate, the resolution, or both. 
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4. If you are capturing audio, use menu item Capture -> Capture Audio to turn 
on the checkmark for audio capture. 

 

5. Set the master stream for audio/video synchronization by using the control 
dialog brought up by Capture -> Master Stream to select whether Audio, 
Video, or None is the master stream for synchronization. 

 

6. You can optionally set a time limit on this capture through the Capture -> Set 
Time Limit dialog. 

7. Once the proper configuration is confirmed, click the Capture -> Start 
Capture menu item, and click OK on the confirmation dialog to begin capture. 

8. If you did not set a time limit, use the menu item Capture -> Stop Capture or 
press the Esc button to end your capture.  

DirectXMedia Details 

Microsoft® DirectX® Media is the media layer of the Microsoft® Windows® 
multimedia system, providing multimedia playback and capture support, image 
transformations, media integration, and animation for the Web and desktop. 

Information Specific to Windows 2000 or Windows XP 

Information Specific to Windows NT 

General Information 
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Information Specific to Windows 2000 or Windows XP 

Windows 2000 and Windows XP both already contain versions of DirectX® Media 
suitable for applications like AmCap and Windows Media Encoder.  The Osprey-540 
driver and applications like Windows Media Encoder also work with the versions of 
DirectX® that Windows 2000 and Windows XP install by default.  If you install a 
third-party application which uses DirectShow, that application may direct you to 
install a newer DirectX® Runtime for Windows 2000 (version 8.0 or 8.1). 

Information Specific to Windows NT 

The DirectX® Media runtime is included on this CD, and can be installed by the 
Osprey installation program. See the Readme.txt file for details. DirectX® Media 
requires that Microsoft® DirectX® 3.0 or later be installed. Windows Service Packs 4 
and later contain DirectX® 3.0. More information about DirectX and Windows NT is 
available at http://www.microsoft.com/directx/homeuser/faq.asp - dx4 

General Information 

More information about DirectX Media is available at: 

http://www.microsoft.com/directx/homeuser/information/dx4nt.asp  

and  

http://www.microsoft.com/directx/homeuser/downloads/default.asp - 
DirectX Media. 

The DirectX Foundation Layer consists of Microsoft DirectDraw®, Microsoft 
Direct3D®, Microsoft DirectInput®, Microsoft DirectSound®, Microsoft DirectPlay®, 
and Microsoft DirectMusic®. Thus, DirectDraw is part of DirectX, and is another 
reason that a video display adapter which supports DirectDraw is desirable.  

More information about DirectX is available at: 

http://www.microsoft.com/directx/homeuser/faq.asp  

and 

http://www.microsoft.com/directx/homeuser/aboutdx.asp 

The latest version of all DirectX downloads can always be found at:  

http://www.microsoft.com/directx/homeuser/downloads/default.asp 

http://www.microsoft.com/directx/homeuser/faq.asp#dx4
http://www.microsoft.com/directx/homeuser/information/dx4nt.asp
http://www.microsoft.com/directx/homeuser/downloads/default.asp#DirectX Media
http://www.microsoft.com/directx/homeuser/downloads/default.asp#DirectX Media
http://www.microsoft.com/directx/homeuser/faq.asp
http://www.microsoft.com/directx/homeuser/aboutdx.asp
http://www.microsoft.com/directx/homeuser/downloads/default.asp
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Because DXMedia is not part of the current DirectX releases, it can be downloaded 
from: 

ftp://www.microsoft.com/developer/platformsdk/july2000/common/redis
t/dxmedia 

The DirectX Media package is distributed with Microsoft’s DirectX 7.0a SDK, which 
can be ordered on CD from Microsoft.  The DirectX Media package has also been 
distributed on the Platform SDK CD in MSDN subscriptions. 

Cropping and Scaling 

The Osprey video capture driver package includes the capability to crop the incoming 
video signal in hardware before it is encoded or captured. Cropping is done by the 
Osprey card and imposes no extra load on the host computer. Use any of the 
following methods to crop the incoming video signal: 

♦ Video Format dialog box 
♦ CropApp, the cropping application 
♦ SDK 

Please see the CropApp Manual which is installed in the Osprey-540 group for details 
on using this feature.  

Ligos Technology Indeo 

Ligos Technology’s Indeo is a software video compressor that works with the Osprey 
Video Capture Driver. It allows you to capture video to disk using much less disk 
space, at the cost of only a slight loss of picture clarity. On a 300 MHz Pentium II 
system you can capture 320x240 NTSC video at a full 30 frames per second with a 
25:1 compression ratio. 

Indeo is included on Osprey-540 driver CDs.  Refer to Chapter 3 - Installing the 
Software - Windows 2000, Chapter 4 - Installing the Software - Windows XP, or 
Chapter 5 - Installing the Software - Windows NT 4.0 for installation information. 

You can also download the most up-to-date version for free on Ligos’ web site. As of 
this writing, the location is as follows: 

http://www.ligos.com/indeo/downloads/ 

The file to download currently is iv5setup.exe. You need a version that compresses 
video as well as decompresses it. 

Indeo Video compressor version 5.11 works with RGB24 and RGB15. It does not 
work with YUV12 or YVU9. However, the Indeo package does include components 
you can use to capture uncompressed YVU9 and 4:2:2 packed video. 

ftp://www.microsoft.com/developer/platformsdk/july2000/common/redist/dxmedia
ftp://www.microsoft.com/developer/platformsdk/july2000/common/redist/dxmedia
http://www.ligos.com/indeo/downloads/
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Use the following steps to demo Indeo with the Osprey card: 

9. Connect and adjust your video source. Start VidCap32. 

10. Use the Options->Format... menu entry to bring up the Osprey driver’s 
Control Dialog Format page. In the drop-down list in the Color Format field, 
select RGB24 (or RGB15). Select ½ sized (CIF) video. Click OK. 

11. Use the Options->Compression... menu entry to bring up the compression 
dialog. In the Compressor: field, select Indeo video 5.11. 

 

12. Before leaving the compression dialog, click the Configure... button. Enable 
Quick Compress in the Encoder Controls field, and click OK. 

 
NOTE: If you do not enable Quick Compress, compression is much slower. 
Click OK again to close the Video Compression dialog box. 

 

13. Select Set Capture File.. under the File menu. Set the name that you want for 
the file that contains the captured video. Click Open. 

14. Select Capture->Video. Select 30 frames per second for NTSC or 25 for 
PAL/SECAM. Click OK. A confirmation dialog displays. Click OK again to start 
capturing video. 

15. Click anywhere on VidCap32 when you want to end capture 
16. Open My Computer and navigate to the icon of the file you just captured. Click 

on it and it plays back. 
If you experience more than one or two dropped frames, use a lower frames per 
second capture rate. Useful rates for NTSC video are 30, 15, 10, and 7.5; for 
PAL/SECAM, 25, 12.5, 8.33, and 6.25. 

Indeo has numerous options. You can obtain higher quality video and more 
compression options by capturing uncompressed video and then compressing it off-
line.  
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Control Panel 

 

The Osprey video capture driver package includes a Control Panel application that 
allows you to control the video source while another application is running. Some 
applications make it hard or impossible to access the driver’s control dialogs while 
they are running. The Control Panel allows you to make these adjustments without 
closing and restarting the primary application. 

Video Input 

Video Format 

Video Adjustments 

Board Select 

Video Input 

The Video Input field controls which of the board’s physical inputs to use. The list of 
available inputs may vary from the illustration depending on the exact hardware you 
have.  

Video Format 

The Video Format field indicates whether NTSC or PAL video is selected and allows 
you to change the format. NTSC is the video standard in North America and Japan. 
PAL is the standard in most European countries, and many other countries as well. 
Please see the section Video Standard for additional information. 
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Video Adjustments 

The Video Adjustment sliders allow you to interactively control the brightness, 
contrast, saturation, and hue of the video being captured or displayed by the primary 
application. PAL video does not have a hue adjustment.  

Board Select 

The Board Select field is displayed and used only when there are multiple Osprey 
cards installed in the system. The buttons of this field determine which of two, three, 
or four boards is currently being controlled. 

 

NOTE: These buttons affect which board is being controlled, not which board 
the application is connected to. Their action is therefore slightly different 
from the Board Select controls in the driver’s internal Setup Dialogs. 
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Chapter 9 - Troubleshooting 

Blue/Pink/Black/Orange Video Screen 

Black Preview Video Screen 

Scrambled Video Image 

Grainy, Dithered Image 

Slow Overlay Drawing 

Problems Using Direct Draw 

Poor Video Quality at Large Frame Sizes 

Wrong Capture Driver Being Accessed 

Unwanted Closed Caption Text 

No Closed Captions on Digital Video 

Interrupt Conflicts 

Multiple Horizontal Lines Across Video Image 

Cannot Play Back Audio Recorded by the Osprey-540 Card 

Video Control Dialog Windows are Empty under WinNT 

Blue/Pink/Black/Orange Video Screen  

The currently selected video input is not receiving an active video signal. Different 
inputs may provide a different symptom when a video source is not supplied. For 
example, with the Osprey-540, if no DV source is connected to the card, the DV 
video may display as a solid pink screen. While playing a tape in a DV camcorder, 
you may see an orange screen at end-of-tape. Video from composite/S-video may 
display as a black screen (maybe with a single horizontal line in it). If no SDI source 
is connected, the video will appear as a solid green field. 

1. Check that the camera, VCR, or other video source is powered and that its 
output is connected to the Osprey card’s input. 

2. Check that the correct video input is selected in the Control Dialog’s Source 
page.  
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Black Preview Video Screen 

If you select a Color Format other than one of the RGBs or Grey8, you may get a 
black preview screen. You may also get a message such as “Error: Unable to draw 
this data format”. The problem is that Video for Windows does not know how to 
decode these more specialized formats. It must be able to locate a software video 
decompressor on your system that works with this format. 

If you encounter this situation with a Color Format that you need or want to use, you 
have to obtain a suitable compressor. For example, if you install Ligos Technology's 
Indeo compressor you can preview the YVU9 format. To download from Ligos's web 
site: 

http://www.ligos.com/indeo/downloads/ 

Scrambled Video Image 

You may have set the wrong video signal format for the signal input you are using. 
For example, you may have told the driver to look for NTSC-M video but are using a 
PAL-BDGHI video source. Make sure you know what signal format your video source 
is generating. Go into the Signal field of the Control Dialog’s Source page, and click 
the button for that signal format.  

Grainy, Dithered Image 

Check that you are using a display format with greater than 256 colors. If a 256 
color format is used, the system can only approximate the actual colors, and does so 
with a loss of resolution and precision.  

Slow Overlay Drawing 

You should be able to obtain 30 frames per second with minimal processor loading 
by enabling Direct Draw. System requirements for realizing this speed are: 

♦ a video display card that supports Direct Draw 

♦ a video display device driver for the card that supports Direct Draw 

Either or both of the two checkboxes in the Direct Draw field of the Control Dialog’s 
Configuration page must be checked. 

Refer also to Appendix E - Direct Draw.  

http://www.developer.intel.com/ial/indeo/video/driver.htm
http://www.ligos.com/indeo/downloads/
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Problems using Direct Draw 

Direct Draw is a recent technology and it is possible that you may have problems 
using it with your particular combination of display adapter, display driver, and 
machine. Any problems should arise only when Overlay mode screen drawing is in 
use; the Osprey card does not use Direct Draw at other times. If you do have 
problems, disable either or both Direct Draw methods by unchecking their boxes in 
the “Direct Draw” field of the Control Dialog’s Configuration page. We have seen 
problems with Secondary Direct Draw on a few older display adapters. Refer also to 
Appendix E - Direct Draw, for more details.  

Poor Video Quality at Large Frame Sizes 

Large frame sizes with the deep pixel depth (24- or 32-bit), or complex format 
(YVU9 or YUV12 planar), impose heavy demands on the PCI bus’s data transfer 
capacity. Our experience is that some systems cannot handle these formats at full 
frame sizes. 

Systems vary in their data transfer limits. The characteristics of the PCI bridge are 
often more important than processor speed. If you are having problems, we 
recommend that you: 

♦ Use a smaller frame size (480 x 320 or less). 
♦ Use a shallower color format (RGB15 or RGB24 instead of RGB32). 
♦ Try an RGB format instead of a YVU format, and a packed format instead of a 

planar format. 

♦ If you have a choice of PCs for video capture, try using another system with a 
different system board chipset.  

Wrong Capture Driver Being Accessed 

This might happen if you already had another capture board/capture driver on your 
system when you installed the Osprey card. The Osprey installation procedure allows 
you to set the Osprey driver as either the primary or secondary video capture driver. 
Appendix D - Using the Osprey Video Capture Driver with Other Video Capture 
Drivers gives a full description of how to set the Osprey driver as the primary driver. 

Some applications, including VidCap32, allow you to select which video capture 
driver to use. In VidCap32, a list of installed video capture drivers is appended to the 
bottom of the Options menu.  
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Unwanted Closed Caption Text 

Closed Caption text consists of white or colored characters drawn on black character 
cells. 

In video that contains Closed Captioning information, the first active line of video in 
each field contains encoded Closed Caption text. In video that does not have Closed 
Captioning information, that line is simply ordinary video. 

If you leave Closed Captioning enabled and view non-Closed Caption video, the 
Osprey video capture driver attempts to interpret the first line of each field of video 
as Closed Caption character codes. Some video may display sufficiently similar to 
Closed Caption data that the software thinks it is Closed Caption text. The result is 
occasional randomly drawn text appearing on the screen. 

The solution is to turn off Closed Captioning when you are viewing sources that are 
not Closed Captioned. To do so, open the Control Dialog’s Closed Caption page and 
uncheck the Enable box in the Display field. The change takes effect when video is 
restarted after exiting the dialog. 

For more information about Closed Captioning, refer to The Closed Caption Page.  

No Closed Captions on DV or PAL Video 

The Osprey-540 is capable of decoding closed captions on NTSC video inputs. This 
feature is supported on SDI and analog video sources - the composite and S-video 
inputs, and digital SDI, only. It is not supported on the DV input.  

Interrupt Conflicts 

Failed network connections, failure of a device drive to initialize during start-up, or 
failure of the Osprey card and driver to operate properly are often traced to interrupt 
(IRQ) conflicts. In our experience, IRQ conflicts are most commonly seen when a PCI 
SCSI adapter, or possibly a PCI network adapter, is present in the system. 

Conflicts Between PCI Cards 

Conflicts of PCI Cards with ISA Cards 
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Conflicts Between PCI Cards 

PCI cards and drivers do not choose which IRQs they use; rather, the operating 
system assigns IRQ lines to PCI cards. The IRQ configuration for the Osprey card or 
cards is determined by Windows NT, and the Osprey driver cannot change this 
configuration. However, you can cause the operating system to assign IRQs 
differently by rearranging cards or changing BIOS settings. 

Multiple PCI cards are supposed to be able to share the same IRQ line. In practice, 
occasionally you may encounter a device driver that is not implemented correctly for 
interrupt sharing. If this problem arises, you have to rearrange the PCI cards so that 
the non-compliant card does not share its IRQ line with any other device. 

Another problem is that some PCI device drivers expect to use a particular IRQ line. 
When a new card is added, it causes the system to assign IRQs differently. If the IRQ 
assignment for a particular card is changed and its device driver does not detect the 
change, this causes the system to work incorrectly. 

The simple answer to this problem is it can sometimes be solved by physically 
rearranging the PCI cards such that their arrangement in the PCI slots is different. 
When doing this, keep careful notes of the arrangements you have tried. 

Another approach to PCI card conflicts is at the BIOS level. Depending on what kind 
of system BIOS you have, you may be able to change which IRQ lines are allocated 
to PCI devices versus ISA devices. You may be able to allocate more IRQ lines for 
PCI devices and thereby solve a PCI conflict. 

If these approaches do not work, see Getting Help in Chapter 1.  

Conflicts of PCI Cards with ISA Cards 

A PCI card and an older-style ISA card can never share IRQ lines. Windows NT 
cannot detect with certainty what IRQ line an ISA card is using and cannot always 
prevent the conflict. 

You can view the system’s IRQ assignments by running the Windows NT Diagnostics 
program in the Administrative Tools menu or program group. Select the Resources 
tab and click the IRQ button at the bottom of the field. If the list of cards shows an 
ISA card using the same IRQ as another device, the conflict should be resolved by 
changing the IRQ of the ISA card. 

Unfortunately, if a device driver for an ISA card has failed to initialize because of an 
IRQ conflict, the card’s IRQ does not display in the list. To find the conflict, you have 
to examine all your ISA cards with the Control Panel to find out what IRQs they are 
trying to use.  
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Multiple Horizontal Lines Across Video 
Image 

If there are multiple, regularly spaced, horizontal lines across your video image and 
your source material is copyrighted and copy-protected, you are seeing  
Macrovision ™ copy protection. It looks like this: 

 

The lines can vary in color from yellow to blue to green. These lines are not present 
in every frame of video. There may also be a black band at the top of the frame. 

The Osprey-540 cannot eliminate these video artifacts. These artifacts are only 
present when you are using a copy-protected source, such as a high-quality DVD for 
testing a card.  

Cannot Play Back Audio Recorded by the 
Osprey-540 Card 

If you have a sound card installed, you should be able to hear audio when you play 
back recorded audio. 

♦ Verify that the volume control for your playback device is not muted. 

♦ Verify that the selected playback device is your sound card, and not the 
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Osprey-540 Placeholder device. The Placeholder device exists in order to handle the 
situation where there is an Osprey-540 present without a sound card. Some 
Windows applications cannot use a recording device unless a playback device is also 
installed. The Placeholder device cannot play back recorded audio. You can use the 
same method to select playback device that you use when selecting the audio 
source. 

Video Control Dialog Windows are Empty 
under WinNT 

This problem occurs only for Windows NT installations that are running Service Packs 
earlier than SP4, or that are running versions of Internet Explorer earlier than 
version 4. The problem is caused by the Osprey driver software's use of features 
(window dialog controls) provided by Windows NT that were introduced in 1999.  

This problem can be fixed by: 

♦ applying NT Service Pack 4 or later.   

 

Service Pack 6a  is required to use Microsoft's Windows Media Encoder 7.1 
and Media Player 7.1. 

♦ installing Internet Explorer version 4 or later 

♦ downloading and installing the latest version of 401Comupd.exe from 
Microsoft's website at 
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.a
sp 

http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp
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Appendix A - Hardware Specifications 

The physical specifications for the Osprey-540 Capture Cards are as follows. 

Table A-1 Physical Dimensions 

Length 133 mm 

Width 22 mm 

Height 121 mm 

Weight 63 grams 

 

Table A-2 Environmental Specifications 

Operating temperature range 0º to 40º C 

Non-operating temperature range -40º to +75º C (RH) 

Operating humidity range Between 5% and 80% (non-condensing) 
@ 40º C 

Non-operating humidity range 95% RH (non-condensing); gradient 
30% per hour 

Operating altitude range 0 to 3,048 meters (10,000 feet) 

Non-operating altitude range 0 to 15,240 meters (50,000 feet) 
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Appendix B - Color Modes 

The Color Format field of the Control Dialog’s Format page allows you to select the 
following video formats. 

RGB32 - Each pixel has four bytes (32 bits) of data - one each for red, green, and 
blue, plus one byte of padding. The pixel has 256 shades of each of the three colors, 
for a total of 16.7 million colors. This is a “true color” mode. 

RGB24 - Each pixel has three bytes (24 bits) of data - one each for red, green, and 
blue. This is another “true color” mode with 16.7 million colors, and is a 
recommended format for capturing images with the highest possible color accuracy. 

RGB15 - Each pixel has two bytes (16 bits) of data. There are 5 bits each of red, 
green, and blue data; the sixteenth bit is unused. This is a “high color” mode, also 
known as “5:5:5.” 

Grey8 - Each pixel has one byte of data, representing one of 256 greyscale levels. 

4:2:2 packed - Also known as YUY2. This mode represents each pixel with a total 
of 2 bytes (16 bits) of data. The data is encoded as separate data for luminance 
(intensity) and chrominance (color). This mode is mainly used as an input to 
software compressors. See below. 

YUV12 planar - Also known as I420. This is a complex format in which there are in 
the aggregate 12 bits of data per pixel. Each pixel has 8 bits of luminance data. Each 
group of 4 adjacent pixels shares two bytes of chrominance data. See below. 

YVU9 planar - Similar to YUV12 planar, except that there are in the aggregate 9 
bits of data per pixel, and each byte pair of chrominance data is shared by 16 
adjacent pixels.  

YUV Format Details 

YUV Format Details 

4:2:2, YVU9, and YUV12 are YUV formats. In these formats, each pixel is defined by 
an intensity or luminance component, Y, and two-color or chrominance components, 
U and V. Since the human eye is less sensitive to color information than to intensity 
information, many video formats save storage space by having one luminance byte 
per pixel while sharing the chrominance byte among two or more pixels. YUV is also 
very similar to the color encoding used for analog color television broadcast signals. 

4:2:2 packed mode consists of a single array of mixed Y, U, and V data. Each pixel 
has one Y (intensity) byte. Each pixels shares its U and V bytes with one of the pixels 
horizontally next to it: 
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Pixels 1 and 2: 

byte 1 = y1 byte 1 intensity 

byte 2 = u1/2 shared U color information for bytes 1 and 2 

byte 3 = y2 byte 2 intensity 

byte 4 = v1/2 shared V color information for bytes 1 and 2 
Pixels 3 and 4: 

byte 5 = y3 

byte 6 = u3/4 

byte 7 = y4 

byte 8 = v3/4 

4:2:2 packed mode uses the same number of aggregate bytes per pixel as RGB15, 
which is two. However, 4:2:2 is more efficient than RGB15 because it stores 
relatively more of the intensity information to which that the human eye is most 
sensitive. 

YVU9 and YVU12 are "planar" modes - the Y, U, and V components are in three 
separate arrays. It is easiest to explain the format with an example: Let's say you 
have a 320x240 YVU9 format. The buffer has 320x240 bytes of Y data, followed by 
80x60 bytes of V data, followed by 80x60 bytes of U data. So each U and each V 
byte together contain the color information for a 4x4 block of pixels. 

Similarly, a 320x240 YUV12 format has a 320x240 Y array, followed by a 160x120 U 
array, and then a 160x120 V array. 

 

Note that in the I420 format used by Osprey, the order of the U and V 
arrays is reversed from the order in the YVU9 format. 
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Appendix C - Video Sizes 

The table below gives the standard video sizes available through the Control Dialog’s 
Format page. 

The 525-line video formats are NTSC-M, NTSC-J, and PAL-M. 

The 625-line video formats are PAL-BDGHI, PAL-N, and PAL-NC. 

CCIR601 is a video proportioning standard that can be selected on the Control 
Dialog’s Format page. 

Available Video Sizes (Width x Height:) 

 525-line 
(Sqr Pixels) 

525-line 
(CCIR601) 

625-line 
(Sqr Pixels) 

625-line 
(CCIR601) 

Full 640 x 480 720 x 480 768 x 576 720 x 576 

1/2 (CIF) 320 x 240 360 x 240 384 x 288 360 x 288 

3/8 240 x 180 270 x 180 288 x 216 270 x 216 

1/4 (QCIF) 160 x 120 180 x 120 192 x 144 180 x 144 
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Appendix D - Using the Osprey Video 
Capture Driver with Other Drivers 

If you already have a video capture driver installed in your system, the Osprey 
installation software offers the option of installing the Osprey driver as your primary 
video capture driver. A dialog box with that option displays near the end of the 
installation sequence. 

The Windows 2000 and Windows XP installers do not offer this option. 

After installation, you can change the primary video capture driver by going to the 
Configuration Page of the driver's setup dialog and then to the Default Capture 
Device option. 

If the Osprey driver is set as your primary video capture driver, it automatically 
connects to Video for Windows applications as the default driver. If you install it as a 
secondary or auxiliary video capture driver, it is not be accessible to Video for 
Windows programs and utilities that lack a control for selecting a specific capture 
driver. Your other driver, however, remains immediately accessible as the default 
driver.  
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Appendix E - Direct Draw 

Direct Draw is a fast on-screen drawing method. The Osprey video capture driver 
utilizes Direct Draw for drawing video overlays. Video overlay is a display mode 
available in most video capture applications, including VidCap32. It is enabled by 
clicking an Overlay button, or by selecting an Overlay menu entry. It is distinct from 
Preview mode. Preview mode does not utilize Direct Draw. 

Direct Draw is enabled by the Direct Draw Enable checkbox on the Control Dialog’s 
Configuration Page. When Direct Draw is enabled, the Osprey driver attempts to use 
it for overlays. If it cannot (e.g., the display driver does not support Direct Draw), 
the Osprey driver defaults to DibDraw. 

When Direct Draw is used, video is copied by direct memory access (DMA) directly 
from the Osprey board to the visible screen memory, and video is overlaid at 30 
frames per second with very low main processor utilization. When Direct Draw is not 
used, video is copied by DMA into system memory, and then copied again into 
display memory. Frame rate without Direct Draw is 30 per second for smaller frame 
sizes, but less for larger sizes, and processor loading is substantial. 

In order to utilize Direct Draw, the following conditions must be met:  

1. You have to enable Direct Draw by checking the Enable button on the Control 
Dialog’s Configuration page. 

2. Your video display card must support Direct Draw. 
3. The software device driver for your video display card must support Direct 

Draw. It is recommended that you use the most recent driver available. The 
drivers on the Windows NT 4.0 CD-ROM do not support Direct Draw in all cases. 
You can obtain the most recent version from your video card manufacturer’s 
web site. 

4. You must be using a video format other than Grey8. The Osprey driver does not 
support Direct Draw of greyscale video. 

5. You can tell whether the system is using Direct Draw as follows: When Direct 
Draw is in use, the display near the video capture window flickers when either 
the video capture window or an overlapping menu or window is moved. When 
DibDraw is being used, there is no flicker. 

6. You can also measure CPU utilization using the Task Manager’s performance 
meter. When measuring CPU utilization, first shut down any applications that 
might be actively consuming significant CPU time. CPU utilization is just a few 
percent when Direct Draw is running. If DibDraw is running, CPU utilization is 
substantial, especially if the image is large.  
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Appendix F - Multiboard Installations 

The multiboard capability of the Osprey-540 Capture Driver allows both single and 
multiple applications to simultaneously access multiple boards. However, the driver 
does not allow multiple applications or processes to access a single board unless the 
added-cost SimulStreaming option has been enabled for the board, or another 
special circumstance exists. 

First, some background on the logic by which the Osprey-540 driver determines 
connection or startup order for multiple boards. The numbering of the boards is 
determined by the order in which the operating system recognizes their presence in 
the slots in which they are installed. The arrangement of logical PCI slots is different 
for different machines, and you should experiment to determine which physical 
board is Board 1. Also, the numbering under Windows 2000 or Windows XP may 
differ from the numbering under Windows NT 4.0. 

Every time the system is rebooted, the Osprey-540 drivers re-enumerate the boards 
in the system and make unique video capture entries for each board. If the Multiple 
Opens box is not checked under Access for Multiple Boards on the Configuration 
Page of the Osprey-540 Video Control Dialog, a "default" registry entry is made that 
represents the legacy method of opening multiple devices, as well as registry entries 
for individual boards. If the box is not checked (selecting the check box is 
recommended), only entries for specific cards are created. 

The Recommended Multi-Board Selection Approach 

The Legacy Multi-Board Selection Approach 

The Recommended Multi-Board Selection 
Approach 

The recommended method is to check the Multiple Opens box on the Configuration 
Page of the Osprey-540 Video Control Dialog. Checking this box should result in the 
generation of only individual device names as video capture device entries. For 
example, the following msvideo entries display for two Osprey-540 devices in the 
system: 

♦ o540vc.dll - Osprey-540 Card 1 

♦ o540vc.dll - Osprey-540 Card 2 

These "Card 1" / "Card 2" names should be used when opening the Osprey-540. In 
the event that you see a "Card Default" entry (see the legacy approach below), this 
is for legacy applications that did not allow for specific device selection. 
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The Legacy Multi-Board Selection 
Approach 

The non-recommended method is to not check the Multiple Opens box on the 
Configuration Page of the Osprey-540 Video Control Dialog. Not checking this box 
should result in the generation of individual device names as well as Card Default 
name as video capture device entries. For example, the following msvideo entries 
display for two Osprey-540 devices in the system: 

o540vc.dll - Osprey-540 Card Default 

o540vc.dll - Osprey-540 Card 1 

o540vc.dll - Osprey-540 Card 2 

If two or more boards are installed and you use the default device name to access 
the Osprey driver, it first connects to the default board. Normally, the default board 
is whichever board was most recently selected in the Control Dialog's Board Select 
field. If this default board is in use (and the MultiOpen option is turned off), the next 
available board is automatically selected. Once any board is selected, you can 
change it to a different board by selecting the desired board in the application you 
are using (often under a menu titled Options or Board Select). 

Multiple boards may be accessed according to two main scenarios: 

♦ Multiple processes accessing multiple boards: Start two standard applications 
- or two copies of one application - such as VidCap32. The first copy comes up 
connected to the default board and starts normally. The second copy 
automatically hunts for the next available board in ascending numerical order. 

♦ A single application accessing multiple boards: A single custom application 
can access two or more different boards. If the standard Video for Windows 
interface is used, the access order is the same as described above.  

♦ Multiple applications accessing single board:  If you have the added-cost 
SimulStream upgrade, then multiple applications can access a single board. 
This option is described in detail in the SimulStreaming User's Guide. 

Multiple Opens is much more precise and flexible for custom applications that use the 
Osprey Video For Windows NT/2000 Software Developers' Kit (VFW SDK). This kit 
allows you to override the default board in order to access any board at any time. It 
is recommended that developers of multiple board applications obtain this kit, 
described in Appendix K.  Please inquire at mailto:info@ospreyvideo.com for more 
information. 

mailto:info@ospreyvideo.com
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Appendix G - File and Registry Usage 

The following are files that are written and registry entries that are set when Osprey 
drivers are installed. This information allows a technically proficient user to remove 
the Osprey-540 installation if the uninstaller is deleted or damaged. 

Instructions for Windows NT 4.0 

Instructions for Windows 2000 and Windows XP 

 

These instructions are for advanced users only! 

Refer to Chapter 3 - Installing the Software - Windows 2000, 
Chapter 4 – Installing the Software – Windows XP, or Chapter 5 - 
Installing the Software - Windows NT 4.0 to remove the software. 
Be careful not to delete or alter any items other than the ones 
described here! 
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Instructions for Windows NT 4.0  

1. Entries are added in the multimedia and system portions of the registry. When 
manually removing the software, use the Control Panel to “Remove” the driver 
(and delete these entries) before deleting individual files and registry entries. 

2. In the main Windows NT ..\System32 directory, these files can be removed: 
chewie.rbf 
Hutt_merge.rbf  
o540board.dll 
o540vc.dll 
o540_mix.dll 
o540ausr.dll 
o540_wav.dll 

Oti.dll 
otiyuv.dll 
SimulKey2.dll 

3. In the main Windows NT ..\System32\drivers directory, these files can be 
removed: 
o540drv.sys 
o540a.sys 

4. The Osprey 540 install driver directory, its subdirectories, and its files can be 
removed. Typically, this directory is \Program Files\Osprey 540 on the default 
drive. The installation procedure puts the following files common to Windows 
NT in that directory: 
CropApp.exe 
CroppingManual.pdf 
o540audstat.exe 
Osprey-540 Special Offers.url 
Osprey-540UsersGuide.pdf 
osprey.ico 
Readme.txt 
SimulStream Special Offers.url 
SimulStreaming_Users_Guide.pdf  
VidCap.hlp 
VidCap32.exe 
xctlapp.exe 

5. The installation program also creates a directory called NT within the Osprey 
540 install directory which contains the following files: 

files DelsL*.isu 
VCLogo.bmp 
VCST1.bmp 
VCST2.bmp 
the Help subdirectory and all its contents 

6. In the registry the following branches are added and can be deleted without 
affecting the rest of the system. Use RegEdit to delete them. 

 

In this branch of the registry, the "1" on wave, mixer, and msvideo may 
be a different numeral, or may not be present. 
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♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ 
Drivers32 device entries: 

"wave1"="o540_wav.dll" 
"mixer1"="o540_mix.dll" 
"msvideo1"="o540vc.dll - Osprey-540 Card 1" 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey540 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\drivers.desc entries: 

"o540vc.dll"="Osprey-540 Video Capture Driver" 
"o540_wav.dll"="Osprey-540 Audio Wave Driver" 
"o540_mix.dll"="Osprey-540 Audio Mixer Driver" 
"o540board.dll"="Osprey-540 Audio Driver" 
"o540ausr.dll"="Osprey-540 Audio Driver" 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation\Osprey Video 

Division\Osprey-540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins

tall\ {A056EAE0-AEFA-11D1-897C-00A02415A964} 
♦  
♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o540drv 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\O540A 
♦ HKEY_USERS\.DEFAULT\Software\Osprey\Osprey540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion\Drivers32 codec entries: 

"vidc.I420 = otiyuv.dll" 
"vidc.yuy2 = otiyuv.dll" 

7. You can delete the Taskbar entry by selecting Taskbar Properties -> Start 
Menu Programs -> Remove. 
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Instructions for Windows 2000 and 
Windows XP  

1. Entries are added in the multimedia and system portions of the registry. When 
manually removing the software, use the Control Panel to "Remove" the driver 
(and delete these entries) before deleting individual files and registry entries. 

2. In the main Windows 2000 or Windows XP ..\System32 directory, these files 
can be removed: 

Hutt_merge.rbf 
chewie.rbf 
o540vc.dll 
o540_wav.dll 
o540_mix.dll 
o540ausr.dll 
o540board.dll 
otiyuv.dll 
Ouno500.dll 
OtiPnp.dll 
SimulKey2.dll 

3. In the main Windows 2000 or Windows XP ..\System32\drivers directory, these 
files can be removed: 
o540drv.sys 
o540a.sys 

4. The Osprey-540 install driver directory, its subdirectories, and its files can be 
removed. Typically, this directory is \Program Files\Osprey 540 on the default 
drive. The installation procedure puts the following files common to Windows 
2000 or Windows XP in that directory: 
CropApp.exe 
CroppingManual.pdf 
osprey.ico 
o540audstat.exe 
Osprey-540 Special Offers.url 
Osprey-540UsersGuide.pdf 
Readme.txt 
SimulStream Special Offers.url 
SimulStreaming_Users_Guide.pdf 
  
VidCap32.exe 
VidCap.hlp 
xctlapp.exe 

5. The installation program also creates a directory called NT within the Osprey-
540 install directory which contains the following files: 
files DeIs*.isu 
VCLogo.bmp 
VCST1.bmp 
VCST2.bmp 
the Help subdirectory and all its contents 



 Appendix G - File and Registry Usage 

Osprey-540 User's Guide – Version 2.1.5  153 

6. In the registry the following branches are added and can be deleted without 
affecting the rest of the system. Use RegEdit to delete them. 

 

In this branch of the registry, the "1" on wave, mixer, and msvideo may 
be a different numeral, or may not be present. 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ 
Drivers32 device entries: 

"wave1"="o540_wav.dll" 
"mixer1"="o540_mix.dll" 
"msvideo1"="o540vc.dll - Osprey-540 Card 1" 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion\drivers.desc entries: 

"o540vc.dll"="Osprey-550 Video Capture Driver" 
"o540ausr.dll"="Osprey-540 Audio Driver" 
"o540_wav.dll"="Osprey-540 Audio Wave Driver" 
"o540_mix.dll"="Osprey-540 Audio Mixer Driver" 
"o540board.dll"="Osprey-540 Audio Board Driver" 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation\Osprey Video 

Division\Osprey-540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins

tall\ {A056EAE0-AEFA-11D1-897C-00A02415A964} 

♦  
♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\MediaResources\

msvideo\!default entry: "Driver" = "o540vc.dll - Osprey-540 Card 1 
♦  

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\O540A 
♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o540drv 
♦ HKEY_USERS\.DEFAULT\Software\Osprey\Osprey540 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion\Drivers32 codec entries: 
"vidc.I420 = otiyuv.dll" 
"vidc.yuy2 = otiyuv.dll" 

7. You can delete the Taskbar entry by selecting Taskbar Properties -> Start 
Menu Programs -> Remove. 
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Appendix H - Adding/Moving Boards in 
Windows 2000 and Windows XP  

Under Windows 2000 or Windows XP, when the driver has been installed and 
another Osprey-540 board is put into a slot that has not previously contained a 
board, the following sequence of windows is initiated. This can happen because an 
Osprey-540 board has been moved to a different PCI slot or when a board is been 
added to the machine. It occurs because of the manner in which Windows 2000 and 
Windows XP enumerates devices. 

Instructions for Windows 2000 

Instructions for Windows XP 

Instructions for Windows 2000  

The New Hardware Wizard runs and displays two windows. A smaller window with 
the text "Found New Hardware, Osprey-540 Video Capture Device, Installing ..." (not 
shown here) may be obscured by the larger Digital Signature Not Found window. 

  

1. Click Yes. 
The Multimedia Video Controller installing window displays. 
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The text inside this window changes to "Osprey-540 Audio Capture Device, 
Installing ..." (not shown here). Then the following Digital Signature Not Found 
window displays on top of it. 

 

2. Click Yes. 
3. When the Completing the Found New Hardware window displays, click Finish. 
4. Two Digital Signature Not Found windows display for each Osprey-540 board 

that you have added or removed. 
5. When the Systems Settings Change window displays indicating that you must 

restart your computer before the new settings take effect, click Yes to restart 
your computer. 

Instructions for Windows XP  

The New Hardware Wizard runs and displays two windows. A smaller window with 
the text "Found New Hardware, Osprey-540 Video Capture Device, Installing ..." (not 
shown here) may be obscured by the larger Digital Signature Not Found window. 
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1. Click Install the software automatically. 
The Found New Hardware Wizard window displays. 

2. Click Next. 
The Found New Hardware Wizard window displays. 
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3. Click Continue Anyway. 
The Found New Hardware Wizard window displays. 

 

4. Click Finish. 
The Found New Hardware Wizard window displays. 
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5. Click Install the software automatically. 
The Found New Hardware Wizard window displays. 

6. Click Next. 
The Found New Hardware Wizard window displays. 
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7. Click Continue Anyway. 
The Found New Hardware Wizard window displays. 

 

8. Click Finish. 
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Appendix I - Developer Support 

The Osprey Technologies group has a software developers’ kit (SDK) to assist 
development of specialized Video for Windows applications. The Osprey Video for 
Windows NT/2000/XP SDK provides capabilities that the Video for Windows API does 
not provide. It uses a proprietary interface that bypasses Video for Windows and 
connects your application directly to the Osprey video capture driver. 

The developers’ kit at present has the following modules: 

♦ Methods by which a single application can access multiple boards - see also 
Appendix F. 

♦ Interactive control of video source, brightness, contrast, hue, and saturation 
from inside an application 

♦ A Closed Captioning API, by which the application can control Closed 
Captioning and capture Closed Caption text for specialized processing and 
display. 

♦ An API for Controlling on-video logos - see Chapter 6, The Logo Page. 

♦ An API for capture of raw Vertical Blanking Interval (VBI) data. 
♦ Direct access to the Bt878 registers. 
♦ Please inquire at mailto:info@ospreyvideo.com for further information.  

 

 

mailto:info@ospreyvideo.com
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